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PREFACE

This manual explains how to use the Horner APG Operator Station products and CBREEZE™ software.

Copyright © 2001 Horner APG, LLC., 640 North Sherman Drive, Indianapolis, Indiana 46201-3899.  All
rights reserved.  No part of this publication may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language or computer language, in any form by any means,
electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without the prior agreement and
written permission of Horner APG, LLC.

Information in this document is subject to change without notice and does not represent a commitment on
the part of Horner APG, LLC.

Windows 95™, Windows 98™, and Windows NT® are registered trademarks of Microsoft Corporation.
DeviceNet is a trademark of Open DeviceNet Vendors Association (ODVA).
Profibus is a trademark of Siemens.
Cscape, CsCAN, and SmartStack are trademarks of Horner APG, LLC.

For user manual updates, contact Horner APG, Technical Support
Division, at (317) 916-4274 (USA), or +353-21-4321266 (Europe) or visit
our web-site at www.horner-apg.com.

LIMITED WARRANTY AND LIMITATION OF LIABILITY

Horner APG, LLC. ("HE-APG") warrants to the original purchaser that the Operator Station manufactured by HE is free from defects
in material and workmanship under normal use and service.  The obligation of HE-APG under this warranty shall be limited to the
repair or exchange of any part or parts which may prove defective under normal use and service within two (2) years from the date
of manufacture or eighteen (18) months from the date of installation by the original purchaser whichever occurs first, such defect to
be disclosed to the satisfaction of HE-APG after examination by HE-APG of the allegedly defective part or parts.  THIS WARRANTY
IS EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES EXPRESSED OR IMPLIED INCLUDING THE WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR USE AND OF ALL OTHER OBLIGATIONS OR LIABILITIES AND HE-APG NEITHER
ASSUMES, NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR HE-APG, ANY OTHER LIABILITY IN CONNECTION
WITH THE SALE OF THE Operator Station.  THIS WARRANTY SHALL NOT APPLY TO THE Operator Station OR ANY PART
THEREOF WHICH HAS BEEN SUBJECT TO ACCIDENT, NEGLIGENCE, ALTERATION, ABUSE, OR MISUSE.  HE MAKES NO
WARRANTY WHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT SUPPLIED BY HE.  THE TERM "ORIGINAL
PURCHASER", AS USED IN THIS WARRANTY, SHALL BE DEEMED TO MEAN THAT PERSON FOR WHOM THE Operator
Station IS ORIGINALLY INSTALLED.  THIS WARRANTY SHALL APPLY ONLY WITHIN THE BOUNDARIES OF THE
CONTINENTAL UNITED STATES.

In no event, whether as a result of breach of contract, warranty, tort (including negligence) or otherwise, shall HE-APG or its
suppliers be liable of any special, consequential, incidental or penal damages including, but not limited to, loss of profit or revenues,
loss of use of the products or any associated equipment, damage to associated equipment, cost of capital, cost of substitute
products, facilities, services or replacement power, down time costs, or claims of original purchaser's customers for such damages.

To obtain warranty service, return the product to your distributor with a description of the problem, proof
of purchase, post paid, insured and in a suitable package.
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ABOUT PROGRAMMING EXAMPLES

Any example programs and program segments in this manual or provided on accompanying diskettes are
included solely for illustrative purposes.  Due to the many variables and requirements associated with any
particular installation, Horner APG, LLC cannot assume responsibility or liability for actual use based on
the examples and diagrams.  It is the sole responsibility of the system designer utilising the Operator
Station to appropriately design the end system, to appropriately integrate the Operator Station and to
make safety provisions for the end equipment as is usual and customary in industrial applications as
defined in any codes or standards which apply.

NOTE: The programming examples shown in this manual are illustrative
only.  Proper machine operation is the sole responsibility of the system
integrator.

DECLARATION OF EMC CONFORMITY

Manufacturer's Name: Horner Ireland Ltd.
Manufacturer's Address: Unit 1, Centrepoint, Centre Park Road, Cork, Ireland

Declares that the products Models: HE500TIU050, HE500TIU100, HE500TIU101, HE500TIU110,
HE500TIU111, HE500TIU200 and HE500TIU201

Conforms to the following EMC standards:

EMC: EN 55 022, Radiated and Conducted Emissions
EN 50 082-1, RF, EFT/EFB, ESD Immunity

Supplementary Information:

The above conformity only relates to the products in a stand-alone capacity.  The products are used as
part of a system and are therefore classified as a component.  As a component, the products are
prohibited by EC regulations to carry a CE Mark for EMC conformity.  Static discharge tests only apply to
normal operation of the keyboards via the front panel.  We would stress that the use of our products
within your system, while helping to ensure compliance of your system to the same directives, do not
necessarily guarantee that compliance will be achieved.  We would also like to point out that the
interpretation of the law concerning CE marking and its application to sub-assemblies and components is
open to interpretation.

Date: 31 Mar 1999
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REVISIONS TO THIS MANUAL

This version (MAN0023-12) of the CBREEZE software for the Tiu Range contains the following revisions,
additions or deletions:

Added Chapter 14 for Graphical Alarm System description.
Added Chapter 15 for CompactFlash® functions.
Added Chapter 16 for Video Objects description.
Added Chapter 17 for Ethernet configuration.
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CHAPTER 1  INTRODUCTION
1.1 Scope
CBREEZE, Horner Electric’s Windows™-based software, is easy-to-use.  The software user’s guide is
contained in this manual.  (See Section 1.4 for initial software installation procedures.)  The current
revision of software is supplied free on our WEB site www.horner-apg.com

A basic level of understanding of Microsoft Windows technology and operation is assumed. The manual
assumes that the user is familiar with Windows 95, Windows 98, Windows NT, Windows 2000 or XP.

Contact your dealer for more information.

Note: The Help File in the Software contains similar information to this manual.

1.1.1 Equipment Needed
a) Software Installation CD.
b) A PC Windows 95™, Windows 98™ ,Windows NT®, Windows 2000 or Windows XP.
c) Approximately 120MB of available hard disk space.
d) TIU050/1xx/2xx/3xx/4xx/TIU5xx/TIU6xx Interface Unit.
e) PC to TIU Programming Cable HE693CBL232 or equivalent (Operator Station Hardware Manual).

Software Installation Instructions

a) Start your Windows™ Operating System.
b) Insert the Software Installation CD.
c) Click the Windows Start menu button and then click Run.
d) The Run dialog box appears.
e) Type D:\setup (CD Drive letter assumed to be D:).  Click OK.

1.2 Upgrade Revision Software & Firmware

1.2.1 General
To use any new features that are included in this new release on units that were purchased previous to
this release, both software and firmware require updating by the user. Any new unit will be set-up for the
latest version released.

1.2.2 Software Upgrade
To update the software requires that the user install the new version of software from the installation CD.
You may install the new software over any previous version installed. See section 1.4 Software
Installation Instructions.
To update existing projects simple open the project from the newly installed version of the software. Once
the project is saved to disk the update is complete. For backup reasons we recommend that you save the
new version of your project in a different location or under a different file name.

1.2.3 Firmware Upgrade
The following steps assume that a project or configuration is loaded to the Operator Station and that the
user is running the latest version of software.
a) Upload the project/configuration from the unit.
b) If a customised character set is loaded to the unit then upload the character set also.
c) Choose AE from main menu Configure/Communication Settings.
d) From File menu choose Update TIU Operating System. (See Updating Operating System for more

details).
e) From File menu choose Update TIU Protocol. If you are updating from firmware version 2.00 or later

then you just have to update to the latest protocol file. However if you are updating from firmware
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version 1.24 or earlier you most update to a Upgrade.1xx protocol file first, then update to the latest
firmware revision. See Note. (See updating protocol for further information).

f) Choose Download Character Sets to TIU from File menu.
g) Choose Download Project to TIU from File menu.

Note: When updating the operating system file the screen may go blank after the protocol file is
complete. Continue with the procedure as described and the display will recover.
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CHAPTER 2  GETTING STARTED
2.1 Self-Test
Power up the unit with the UP and ENTER keys pressed at the same time.  The unit enters a self-test
mode. The self-test consists of the following four checks:

2.2 Contrast Band
This test allows the user to set the lower and upper limits of contrast.  Adjust the lower limit using the UP or DOWN
key and press Enter when done.  Do the same for the upper limit.

Note: Self test - The contrast band adjustment is only available on Tiu1xxs and TIU050

2.3 Display Test
The display test continuously blinks all pixels on (black) to off.  Look for any pixels stuck on or off.  Exit
this test by pressing and holding any key for approximately two seconds.

2.4 Keyboard Test
As each key is pressed, an indication *** appears above that key. In the case of units with a numeric
keypad, press the key and a message appears indicating the key press.  Check for keys indicating
multiple presses or not reporting presses.  Exit this test by pressing and holding any key for
approximately two seconds.

2.5 RAM Test
Test either segment 0000 or segment 1000 (on the HE500TIU100/110) of the RAM.  The segment 1000
test performs a base 3 repeating test.  This test detects shorted address lines and damaged memory bits.
The segment 0000 test performs a Read-Modify-Write test on each byte of RAM, detecting damaged
memory bits.  Exit this test by selecting DONE.

2.6 Serial Loop-back Tests
Tests the PC port and the Serial Port in each of it’s three modes for serial loop-back.  Pre-made plugs are
required to link the pins of a particular port. This takes the following form:

Table 2.1 Loop-back Test Plugs
Port Tested Product Type of Connector Pins to Short

PC (J2) HE500TIU100/110 Pin male D link connector pin 2 to pin 3
RS-232 (J3) HE500TIU100/110 13-pin phoenix connection pin 6 to pin 8
RS-422/485 (J3) HE500TIU100/110 13-pin phoenix connection pin 2 to pin 4 and pin 3 to pin

5.
Current Loop HE500TIU100/110 13-pin phoenix connection pin 1 to 9, pin 10 to 11 and pin

12 to 7
PC HE500TIU050 Pin male D link connector pin 2 to pin 3
RS-232 HE500TIU050 8-pin phoenix connection Pin 5 to pin 7
RS-422/485 HE500TIU050 8-pin phoenix connection Pin 1 to pin 3, Pin 2 to pin 4
NOTE: current loop in not installed on standard models, as such a standard model will fail the current
loop-back test. Current Loop is not an option on the HE500TIU050/20X.

After starting the test, the OK counter begins to count up.  Exit this test by selecting DONE.
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2.7 Selecting the Automation Equipment (AE)

The following points are covered in this section:

a. Connecting a PC to the TIU;
b. Choosing the AE connected to the TIU,
c. Selecting the protocol to be used.

1. Install the CBREEZE software on your PC (if not already done).  Double-click on CBREEZE Software
icon; and the default screen shown below appears.

2. From Configure, pick Select Terminal Type and choose the model.

3. Connect the TIU (PC Port) to a serial port (COM1, 2, 3 or 4) on the PC.  From the Configure menu,
choose PC Comms Port and the applicable Comm port.

4. Connect power (+24VDC) to the TIU.  Power-up the unit.  The type of protocol currently installed is
displayed in the lower half of the screen during power-up.

5. If the AE is different than the protocol currently installed on the TIU, a new protocol must be loaded.

Figure 2.1 - Default Screen
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6. From the Configure menu, click Communication Settings and select manufacture of the AE,
followed by the type.  The default setting for this equipment will be displayed in the window. Click OK
to accept.

Figure 2.2 – AE Configuration Box

7. If the default setting does not match the communications settings of the AE, select the appropriate
Baud Rate, Parity, Data Bits, Stop Bits and Communication Mode.

8. Network Mode enables the user to connect to one or many similar remote devices. Where a single
device is to be accessed disable network mode and enter the station address of the connected device
as the Global Remote Node ID.

Note: If connecting the TIU to a number of devices on the AE port (i.e. a multidrop system) then the
Network mode enable box should be ticked, and the node id required will need to be entered whenever
an automation equipment reference is required.
Note: If connecting the TIU to a sing  the network mode enable box should
be unticked and the node ID for the 
equipment registers will now assume

To update the protocol, select File, t
form: - {plc_type}_r{release number}
Where AE type is a prefix dependen
Tiu050, 1xx for Tiu1xx, 2xx for Tiu2x

Note: Prior to release 4, protocol file
le device on the AE port then

single device entered as the global remote ID. All references to AE
 the global remote ID number entered here.

hen Update TIU Protocol. The protocol file names take the general
.{ser}
t on the protocol, release number is currently 6 and {ser} is 0xx for
x etc.

 names were of the form: - {plc_type}.{type} where type was LOS for
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Tiu050 BOS for Tiu1xx and GOS for Tiu2xx. Dependant on the protocol and terminal type selected the
standard windows file open box will be displayed with the filename selected accordingly. Select the
protocol file you wish to download.

The appropriate protocol file for previously selected the automation equipment will be displayed in the file
name window. Select the folder name for the appropriate terminal type (0xx for Tiu050, 1xx for Tiu1xx
and 2xx for Tiu2xx). Click OK.  A “SYSTEM SHUTDOWN” message appears on the TIU.

2.8 Proving Communications

Connect the TIU to the automated equipment using the cable drawing provided.

The following steps verify communications between the TIU and the automation equipment.  The figures
shown here are for the HE500TIU100.  Methods are exactly the same for the all products in the TIU
range.

1. Click on the Wizards Icon  in the tool bar and choose Comms Stats. The display should then
look like figure 2.3.

Note: The TIU only communicates if an embedded data is put on the screen

Figure 2.3 – Start-up Menu
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2. The settings can be saved.  To do this, select Save Project As from File.  Enter a file name and click
OK.

3. Download the project to the TIU.  To do this, from the File menu select Download Project to Tiu.  A
status bar appears indicating the progress of the download.  On the TIU Display Screen, “SYSTEM
SHUTDOWN” appears.  A message of “Transfer Complete” appears when the data has been
successfully downloaded.

Note: If the error “Link Failed” appears, check the cable connection between the PC and TIU.

4. After the transfer, the TIU resets itself and the correct automation equipment type is shown
temporarily on the Display Screen.

5. On the Display Screen, the “GOOD” number of communications should be equal to the “TOTAL”
number of communications.  The content of the embedded data, on the top line, depends on the
existing data in that register of the PLC.

2.9 Icon Descriptions

The TIU software main screen is shown in Figure 2.4.  Along the top are several short cut icons.  Many
are standard Windows™ icons, some however, are special function.
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2.10 Up/Down Keys

Left clicking on the “Up” and “Down” keys on the project window has the same effect as “Up” and
“Down” key presses (i.e., scroll up/down through the current menus).  Right clicking on the “Up” and
“Down” keys on the project window have the same effect as Ctrl-Page Up and Ctrl-Page Down key
presses (i.e., enter sub menu, and leave sub-menu, respectively). If a sub-menu does not exist a
message appears saying “This page does not have a sub-menu, would you like to create one?” See
Creating a sub-menu later in this manual.

2.11 Key Symbols

The symbols for the four keys can be added to display pages using the PC function keys F2-F5.  The
keys are assigned as follows:
1. F2 = PAUSE
2. F3 = UP
3. F4 = DOWN
4. F5 = ENTER

Figure 2.4 – HE500TIU050/100/110 Software Screen
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CHAPTER 3  ABOUT PROJECTS
3.1 Scope

This chapter describes the procedure for configuring the TIU.  This includes loading, saving, downloading,
uploading, verifying and updating the protocol.

3.2 About TIU Terminal
This new feature allows the programmer to see what version level the connected terminal is at and how it
is configured. The information give is;
a. Operating System Version Level
b. Firmware Version Level
c. Protocol Version Level
d. Remote Equipment Manufacture
e. Remote Equipment Model

This can be used as a useful diagnostic tool when updating operating system and firmware. From the
main menu click Help/About TIU Terminal, a window similar to Figure 3.1 appears.

Figure 3.1 About TIU Terminal Configuration
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3.3 Creating a New Project
1. Select New from the File menu.
2. The following prompt window appears:

3. Click OK.

3.4 Opening a Project
1. Press the “open folder” icon on the program display screen or select Open Project from the File

menu.
2. Select the proper file name from the list of available projects (with “cmc” extension).
3. Click OK.

3.5 Saving a Project
1. If the project has been previously saved during the current session, press the “floppy” disk icon on the

program display screen or select Save Project from the File menu
2. If this is the first time saving this project to a file, select Save Project As from the File menu.
3. Enter the file name and destination.  Click OK.

3.6 Downloading a Project
Prior to the download the software checks if following conditions are correct: -
a) The correct TIU terminal is connected to the PC.
b) The correct Protocol file is loaded to the terminal.
c) The current revision operating system and firmware revision.

Note: If the message “Link Failed” appears, check the cables connecting the PC to the unit.

Note: If the message “This Terminal is fitted with the incorrect PLC protocol. Load the correct protocol
before loading the configuration into the terminal”. The project and the terminal are not set-up for the
same protocol. If the project is correct then download the correct protocol file to the TIU.

1. Select Download Project from the File menu.  A status bar appears; indicating the download is in
progress.

2. After the project has been downloaded, the message “Transfer Complete” appears.
3. After the transfer, the TIU resets itself.
4. The downloaded project now runs.

3.7 Uploading a Project
1. Select Upload Project from the File menu.
2. A status bar appears; indicating the upload is in progress.

Note: If the message “Link Failed” appears, check the cables connecting the PC to the unit.

3. After the project has been uploaded, the message “Transfer Complete” appears.

Figure 3.2 – New Project
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3.8 Verifying a Project
1. Select Verify Project from the File menu.
2. A status bar appears indicating verification progress.
3. The Verify will stop at all reported errors
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3.9 Updating the Protocol
When the software is installed the user decides where the main CBREEZE folder resides. During
installation the following folders are created: -

In the protocol directory 7 folders are created, TIU0xx, TIU1xx, TIU2xx TIU3xx, TIU41x, TIU42x and
DeviceNet Protocols. The DeviceNet Protocols folder contains two sub folders called tiu1xx and tiu2xx.
The protocol files for the different terminal are loaded into these folders. The protocol files for the
HE500TIU050 are loaded into Tiu0xx, the protocol files for the HE500TIU10X are loaded into Tiu10x, the
protocol files for the HE500TIU20X are loaded into Tiu20x, The protocol files for the HE500TIU41x,
HE500TIU51x and HE500TIU61x are loaded into the TIU41x folder, etc. There is one other folder created
in the top level called SerialSlaves.  Serial Slaves contains two sub folders called tiu1xx and tiu2xx.

The name of the protocol file is broken up into three sections, the protocol, the main software revision and
the terminal type that protocol file is for.

Example
snp_R4.1xx
This is the protocol file for release 4 software for the GE FANUC PLC, for the HE500TIU10X
df1_R4.2xx
This is the protocol file for release 4 software for Allen Bradley PLC, for the HE500TIU20X

To Update Protocol File
1. Set Terminal Type
2. Set the required Automation Equipment in Communications Settings
3. Select Update TIU Protocol from the File menu.
4. Select the folder of the terminal you have connected to the PC. The correct file will appear for the

terminal type selected and the Automation Equipment selected. Select that file and click OK.
5. A status bar appears indicating download progress.
6. After the transfer, the TIU resets itself.  The correct PLC type is displayed on the TIU.
7. Next, the project loaded runs.

3.10 Updating the Operating System (Not Applicable on the TIU3xx, TIU41x/51x/61x,
TIU42x/52x/62x)

1. There is a different operating system file for each terminal type. Therefore select terminal type first
and the software will request the correct file name for the current terminal type selected.

2. Select Update Operating System from the File menu.
3. Choose the updated file with the “BIN” extension. The operating system files are stored in the OS

folder under the CBREEZE folder. Only the correct file name will be displayed. Click OK.
4. A status bar appears indicating download progress.
5. During the download process, TIU displays the message “SYSTEM SHUTDOWN”.

Protocol Name _ Software Revision . Terminal Type
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3.11 Printing
Cbreeze software has printout capability.  To print, select Print from the File menu or click on the Print
icon.  The system parameters (# of menu pages, # of alarm pages, # of status pages, PLC type, port
settings, communication configuration, and PLC station number) and all of the pages are printed.

The printer set-up is selecting Printer Setup from the File menu.  The printer set-up screen is shown in
Figure 3.3.

3.12 To Insert a New Page
1. Click on the Insert Page Icon or from Edit choose Insert Page.
2. Pages can either be Insert After Current Page or Insert Before Current Page.  Also, select the

number of pages to be inserted.  Click OK.

3. If the user goes to the last page of the project and clicks on the down key a message appears saying
“There are no more pages in this menu, do you want to create some?” If the OK button is pressed the
above insert menu pages appears.

3.13 Default Page Type
(Graphics Models Only)
With the HE500TIU20X, HE500TIU3XX, HE500TIU41x/51x/61x and HE500TIU42x/52x/62x series there
are two types of pages.
a. Text Page
b. Graphic Page

Figure 3.3 – Printer Set-up Box

Figure 3.4 – Insert Pages Message
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The CBREEZE Software may be set-up to create either type of page by default or alternatively the
software can be set up to display a prompt asking which type page is to be created every time a page or
pages is inserted. (Prompt On Page Creation).

Text Page
A text page in the Graphics units is similar to the normal page created with the HE500TIU10X/11X, i.e.
the same functions that are available on the HE500TIU10X/11X are also available on a Text Page of the
Graphics unit. To use the extra graphic features of the HE500TIU20X a Graphic page must be created.

Graphic Page
A graphic page can be used to display all the features of the Text Page plus the extra features available
for a Graphic Page. See chapter on Graphic Editor for further details of features available.

3.14 Download/Upload Character Set (Not available with the HE500TIU050)
After new characters have been created with the character generator, these characters must be
downloaded to the TIU.  Conversely, an existing character set in the TIU can be uploaded.

3.14.1 To Download a Character Set:
1. Select Download Character Set to Tiu from the File menu.  A status bar appears; indicating the

download is in progress.

Note: If the message “Link Failed” appears, check the cables connecting the PC to the unit.

2. After the project has been downloaded, the message “Transfer Complete” appears. The new
character set is now loaded to the TIU.

3.14.2 To Upload a Character set from the TIU:
1. Select Upload Character Set from the File menu.
2. A status bar appears; indicating the upload is in progress.
3. After the project has been uploaded, the message “Transfer Complete” appears.

3.15 Select Terminal Type
This software package supports the projects of multiple Operator Stations (TIUs).

3.15.1 To select the Operator Station Terminal Type:
1. From Configure, pick Select Terminal Type and choose the model.
2. Choose the model or TIU being used. The screen changes to show the model just selected.

3.16 Delete a Page
1. Go to the page to be deleted.  Click on the Delete Page icon or from Edit choose Delete Page.
2. The current page is deleted and the next page is displayed.

3.17 Font Size (Not available with the HE500TIU050)
There are four different Font Sizes: Normal, Double Height, Double Size (x2) and Four Times Size (x4).
The size of an entire line is set, individual words on a line cannot have a different size then other words.

3.17.1 To change/set the Font Size of a line:
1. Click somewhere on the line to be adjusted.
2. Click on the desired Font icon.  The size of the entire line is adjusted.  Any characters beyond the

right border of the screen are maintained but not displayed in the CBREEZE software or on the TIU.
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NOTES
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CHAPTER 4  EMBEDDED DATA

4.1 Scope
Embedded data fields allow data from external connected devices or internally generated data to be
displayed on the screen of the Tiu. The following types are supported

• Numeric (Display / Modify)
• Alphanumeric (Display Only on the HE500TIU10X, Display / Modify on all other models)
• Timer (Display / Modify),
• Bit status (Display / Modify)
• System variable(Display Only)
• Password (Display / Modify)
• Horizontal Fill (Display Only)
• Text Selector (Display / Modify)
• Recipe Item (Display / Modify)
• Clock Calendar (Display / Modify)

Maximum embedded data fields by terminal family

Tiu Family Maximum embedded data
fields per text page

Maximum embedded data
fields per graphics page

TIU050 8 N/A
TIU1XX 8 N/A
TIU2XX 24 64
TIU3XX 24 256
TIU4XX 24 256
TIU5XX 24 256
TIU6XX 24 256

Many of the sections in this chapter contain specific instructions that are intended to serve as
examples only.

There are following are the various ways of embedding data on to the Tiu screen.

 Double click the Display window area.
 Click the Embed Data icon on the toolbar

 Click a specific embedded data icon from the toolbar

 Chose Edit/Embedded data from the menu.
 Press Shift and Enter Keys together.
 Right click the mouse and then select ‘Embedded Data’
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Unless a specific embedded data type is chosen the following data type selection box is displayed (Fig
4.1). From this the type of data to be embedded may be chosen.

Figure 4.1 – Choose Embedded Data Type

4.2 Numeric Data

This section describes the Numeric Data formatting functions available in the Tiu Range. Use the
instructions as follows to embed Numeric Data.

From the Embedded data list select Numeric Data, the screen shown in Figure 4.2 appears.

Numeric
Data Type

Alphanumeric Data Type Timer Data Type Bit status Password

Clock Calendar

Recipe Item

Analog Meter Graph

Trend

Text Selector

System
Variable

Animated
Bit Map
Selector

Lamp

Meter

Curved
Analog FillSlider

Toggle
Switch
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Figure 4.2 – Numeric Embedded Data Formatting

4.2.1 Remote Data Source
Select where the source of the date to be used is. This can either be a register within the connected AE
or an internal register. Drop down the data type box to select the register type to be used and specify the
register number in Location. Where AE Network mode has been selected the PLC node ID from which
this variable should be obtained can be specified in node ID.

4.2.2 Display Format
Select the display format required. This may be any of hexadecimal, decimal, octal or binary.

Where decimal is selected a fixed decimal point may be added to the number. For example if XXX . X is
selected 1234 is displayed as 123.4

Select whether the numeric should be 16 or 32 bit, and signed or unsigned.

Where32 bit is selected and the register type specified as stored in the AE is 16 bit (which is true of the
majority of PLCs) two contiguous registers are automatically read from the AE and concatenated to form
a 32 bit value.
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Where 16 bit is selected and the register type specified as stored in the AE is 32 bit (for example on the
Moog PSC100) the upper word of the register read is automatically masked.

4.2.3 Edit/Write
Select whether the data is to be editable by the operator once the system is installed. In order for this to
be the case check the ‘Edit enable’

4.2.4 Range Checking
Available only when the format is selected for edit enable enabling range checking this allows the range
of values entered by the operator to be restricted to be within a minimum and maximum value.

4.2.5 Scaling
Use scaling settings where the values read from the PLC need to undergo a conversion prior to being
displayed on the PLC.
For example, a 12 bit analog input to the connected device gives a reading in the range 0 to 4095. This
corresponds to a weight of 0 to 100 kg attached to a load cell. It is required to display this load on the Tiu
display with accuracy to 0.1kg. It is possible to read the Raw value from the connected device and apply
the following scaling conversion to produce the required reading on the Tiu display, with no need for any
conversion mathematics within either the AE or the Tiu.

Figure 4.3 - Numeric Scaling Example

Changing data register contents from the TIU…
1. Press the Pause ( || ) key to select the data field for editing. The selected field becomes highlighted.
2. To increment the data, press the Up key. (If range checking is enabled then it will not be possible to

increase the value above the maximum value specified)
3. To decrement the data, press the Down key. (If range checking is enabled then it will not be possible

to decrease the value below the minimum value specified)
4. On Terminals other than the TIU1XX series the numeric pad may be used to key in a value directly.
5. To enter the data to the AE, press the Enter key. Note that if the value entered is out of bounds of the

range specified, the display will briefly indicate an out of range status then revert back to edit mode
with no write to the AE occurring.

Format Minimum Value Maximum Value
16 Bit Unsigned 0 65535
32 Bit Unsigned 0 4294967295
16 Bit Signed -32768 32767
32 Bit Signed -2147483648 2147483647
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4.3 Alphanumeric Data

This section describes the Alphanumeric Data formatting functions available in the Tiu Range. Use the
instructions as follows to embed Alphanumeric Data.

From the Embedded data list select Alphanumeric Data, the screen shown in Figure 4.4 appears.

Figure 4.4 – Alphanumeric Embedded Data Formatting

4.3.1 Remote Data Source
Select where the source of the date to be used is. This can either be a register within the connected AE
or an internal register. Drop down the data type box to select the register type to be used and specify the
register number in Location. Where AE Network mode has been selected the PLC node ID from which
this variable should be obtained can be specified in node ID.

4.3.2 Display Format
Select the number of characters that the displayed string should contain. The number of registers to be
read in order to form the string will be determined by the string length. Each 16 bit register will provide two
characters, and each 32 bit register will provide four characters.

4.3.3 Edit/Write
Select whether the data is to be editable by the operator once the system is installed. In order for this to
be the case check the ‘Edit enable’
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4.4 Timers

This section describes the Timer Data formatting functions available in the Tiu Range. Use the
instructions as follows to embed Timer Data.
From the Embedded data list select Timers, the screen shown in Figure 4.5 appears.

Figure 4.5 – Timer Embedded Data Formatting

4.4.1 Remote Data Source
Select where the source of the date to be used is. This can either be a register within the connected AE
or an internal register. Drop down the data type box to select the register type to be used and specify the
register number in Location. Where AE Network mode has been selected the PLC node ID from which
this variable should be obtained can be specified in node ID.

4.4.2 Display Format
Select a timer format under Format.  Table 4.1 shows the available timer format.  A 32-bit timer reads two
contiguous registers.



CH. 4: EMBEDDED DATA                               30 June 2004                                                           PAGE 35
MAN0023-13

Table 4.1 – Configurations for Timer Format
16-Bit MM:SS 12 Hour             Minutes & Seconds
16-Bit HH:MM:SS 12 Hour Hours, Minutes & Seconds
16-Bit MM:SS_T 12 Hour Minutes, Seconds & 10th of Seconds
16-Bit HH:MM:SS_T 12 Hour Hours, Minutes, Seconds & 10th of Seconds*
16-Bit HH:MM 12 Hour Hours &Minutes.
32-Bit MM:SS 24 Hour Minutes & Seconds
32-Bit HH:MM:SS 24 Hour Hours, Minutes & Seconds
32-Bit MM:SS_T 24 Hour Minutes, Seconds & 10th of Seconds
32 Bit HH:MM:SS_T 24 Hour Hours, Minutes, Seconds & 10th of Seconds
32-Bit HH:MM 24 Hour Hours &Minutes
* up to a maximum of 1:49:13.5

4.4.3 Edit/Write
Select whether the data is to be editable by the operator once the system is installed. In order for this to
be the case check the ‘Edit enable’
1. Check the Range Checking box to enter a Maximum and Minimum range.
2. Range checking can be entered in SECONDS; MINUTES, SECONDS; or HOURS, MINUTES,

SECONDS.

4.4.4 Range Checking
Available only when the format is selected for edit enable enabling range checking this allows the range
of values entered by the operator to be restricted to be within a minimum and maximum value.

4.4.5 Scaling
Use scaling settings where the values read from the PLC need to undergo a conversion prior to being
displayed on the PLC.
For example, the timer to be displayed is actually counting in 0.01 second increments in the PLC. Use the
following Scaling settings to convert this to a 0.01 second timer on the Tiu display, with no need for any
conversion mathematics within either the AE or the Tiu.

Figure 4.6 - Timer Scaling Example

To edit the data field on the Tiu
1. While displaying the appropriate page, press the Pause key to select the data field for editing. The

selected field becomes highlighted.
2. To increment the data, press the Up key.
3. To decrement the data, press the Down key.
4. To enter the data to the PLC, press the Enter key.  If range checking is active, then increment and

decrement are only allowed between the maximum and minimum ranges.
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4.5 Bit Status

This section describes the bit status functions available in the TIU.  Use the instructions as follows to
embed Bit Status.

From the Embedded data list select Bit Status, the screen shown in Figure 4.7 appears.

Figure 4.7 – Bit Status Embedded Data Formatting

4.5.1 Remote Data Source
Select where the source of the date to be used is. This can either be a register within the connected AE
or an internal register. Drop down the data type box to select the register type to be used and specify the
register number in Location. Where AE Network mode has been selected the PLC node ID from which
this variable should be obtained can be specified in node ID.
If an analog Data Type is chosen, then an additional bit number will be prompted for.

4.5.2 Display Format
Select a ‘Token Pair’ from the list of available pairs. (“OFF”/”ON” for example). To modify the list of
available pairs click on the ‘Edit Tokens’ button, select the pait to modify and then enter the “ON” and
“OFF” descriptions (up to 10 characters) in the Enter Bit On Token and Enter Bit Off Token boxes. After
being modified, the modified token pair can now be selected as normal.

4.5.3 Edit/Write
Select whether the data is to be editable by the operator once the system is installed. In order for this to
be the case check the ‘Edit enable’

Modifying the bit value when editing is enabled
1. From the appropriate page, press the Pause key. The selected field becomes highlighted.
2. To turn the bit off press the Down key arrow, or if applicable the ‘0’ key on the numeric pad.
3. To turn the bit on press the Up key arrow, or if applicable the ‘1’ key on the numeric pad.
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4. Press “Enter” to send the data to the PLC.

4.6 System Variables

This section describes the system variables available in the TIU.  Use the instructions as follows to
embed system variables.

There are six different types of system variables. To embed system variables:

Figure 4.8 – System Variable Embedded Data Formatting

1. From the embedded data list select System Variable.
2. Select a system variable type under Select System Variable in the Format section.
3. Click OK.

4.7 Passwords

This section describes the Password function available in the TIU.  Use the instructions as follows to
embed Password.

Figure 4.9 – Password Embedded Data Formatting
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4.7.1 To password protect a sub-menu:
1. From the embedded data list select Password. A series of question marks appear on the screen.

Click OK
2. Select Create SubMenu from the Edit menu. Enter the number of pages, you then have the option of

password protecting the submenu.

Figure 4.10 – Configure Password Authority Mode

3. There are two types of security access on sub-menus.
• Simply one password to enter the sub-menu
• Authority Level Mode

The Authority Level Mode allows the programmer to give security levels to each sub-menu. Click
Authority Level Mode and then enter the Authority Level to that sub-menu. Each Level can be given an
individual password.

4.7.2 To enter the password from the TIU:
1. In the appropriate page, press the Pause key. The selected field becomes highlighted.
2. Enter the password by incrementing or decrementing the data field, by pressing the Up or Down key

respectively.
3. Press the Enter and Up keys simultaneously.
4. The data must be equal to the pass code in order to enter into the sub-menu.
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4.8 Analog Meters

This section describes the Analog Meters function available in the TIU.  Use the instructions as follows to
embed Analog Meters.
An area of the display can be horizontally filled to create an analogue meter or gauge.  The height of the
block is fixed at the height of the current text line.  To create a horizontal fill:
1. From the embedded data list select Analog Meters.

Figure 4.11 – Analog Meter Embedded Data Format

4.8.1 Remote Data Source
Select where the source of the date to be used is. This can either be a register within the connected AE
or an internal register. Drop down the data type box to select the register type to be used and specify the
register number in Location. Where AE Network mode has been selected the PLC node ID from which
this variable should be obtained can be specified in node ID.

4.8.2 Display Format
Select the Number of Characters that the fill should occupy. The actual width and resolution of the fill
will be dependant on the font size in which the fill is displayed.

4.8.3 Range
Select the values that will correspond to empty (minimum) and full (maximum) for the fill.

NOTE Only Linear Scaling is supported directly
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4.9 Text Selector

This section describes the Text Selector function available in the TIU.  Use the instructions as follows to
embed Text Selector.

Text Tables are available in the TIU CBREEZE software. There are 250 available text tables for use and
they may be numbered from 1 to 250. Each text table may have up to 256 entries (numbered 0 to 255).
Entries within each table may be called up by using the selected PLC register. When the ID of the entry is
called up in the PLC register, the text string (entry) is displayed. The text strings are automatically forced
to the width of the longest text string in the table (selected table). Strings are automatically left justified.
Text tables are typically used in situations where the operator desires a visual message when some event
(such as a value change in a register) occurs.

Example: A PLC is controlling a process that manufactures one of four drink types: Cola, Lemonade,
Orange Juice, and Apple Juice.

The PLC has a register that contains the value of “6” when Cola is being made, “8” when lemonade is
being made, “12” when Orange Juice is being made and “24” when Apple Juice is being made.  A Text
table can be created with four entries, 6, 8, 12 and 24, with the text for these items being the four
products.  Now, the PLC register can be monitored and the appropriate text inserted into a page on the
HE500TIU050/100/110.

A maximum of 64kBytes can be used by all of the text tables.

4.9.1 Edit Text Tables
Text tables can be edited from the HE500TIU050/100/110.  To choose the Text Selector function:

1. Select Text Selector embedded data list.

Figure 4.12 – Text Selector Embedded Data Format
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4.9.2 Remote Data Source
Select where the source of the date to be used is. This can either be a register within the connected AE
or an internal register. Drop down the data type box to select the register type to be used and specify the
register number in Location. Where AE Network mode has been selected the PLC node ID from which
this variable should be obtained can be specified in node ID.

4.9.3 Display Format
Select a text Table ID number (1-250).
To modify the entries within a text table click the edit table button.

4.9.4 Edit Enable
Select this check box to enable the editing of the register controlling the text table direct from the front
panel of the Tiu.

4.10 Editing a text table’s entries
To create/edit/delete entries, click the Edit Table button. The Text Table editor dialog box appears as in
Figure 4.13

Figure 4.13 – Text Table Editor

A Text Table box appears and the user has the ability to Add, Delete, and Edit text strings.

4.10.1 To Add an Table Entry
1. Click Add. Figure 4.14 is displayed.

Figure 4.14 – Text Table Field Entry
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2. The field ID is automatically the next the available number in the table. This can be changed by typing
in the number required or incremented using the up and down buttons to the right of the field.

3. In the text field enter the text corresponding to that field ID.
4. The size of the font that will be used to display the text table can then be set to the character set sizes

6 x 8 or 12 x 16. Note that if custom characters are used in the text table, then using the incorrect font
when displaying the text table on the Tiu will prevent the table entries from being displayed as
intended

5. The programmer can enter the customised character generator by clicking edit font, see Chapter on
Character Generator for further details.

4.10.2 Decimal, binary and hexadecimal Table Modes
Text tables can be called in 3 different modes, Decimal, Binary and Hexadecimal. This refers to the
format of the data in the register calling the text table. Also in Binary mode multiple text table entries can
be displayed the user can then scroll between these text table entries, or set the Auto Scroll option to let
the TIU to automatically scroll between all the selected entries.

4.10.3 Export a Text Table
1. Click the Export button.
2. Enter the location of the file.
3. Enter the name the file the text table is to be exported to.

4.10.4 Import a Text Table
1. Click the Import button.
2. Click on the file to be imported.

To edit a text table from the TIU:
1. Select the text string field by pressing the Pause key.
2. Move up or down the list using the Up and Down keys.
3. Press the Enter key to select the desired text string.

4.10.5 Auto Mask Bit
The Auto Mask function allows the programmer is a function, which allows the programmer to mask off a
specified number of bits in a register.  When the Auto Mask Bit is selected an extra field appears in the
Configure Text Selector Embedded Data window called Bit Offset. This field contains the number of bits
to be masked off beginning with the first bit of the register.

4.10.6 Default Text Table Entries
If an undefined value is entered into the text table entry field (i.e., a value that has not been assigned in
any text table), then one of two different things happen.

a. If the user has assigned a value to the Default Entry in the Text Table box, then that entry number is
displayed. This value is assigned by first checking the box next to Default Entry, then entering a
number in the box below.

b. If the box is unchecked and a default entry has not been selected, then a series of asterisks
(corresponding to the longest entry in the text table) are displayed.
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Example: There are five entries in a text table.

Figure 4.15 Default Text Selector Example

These five entries have numbers of 23, 24, 54, 67 and 100.  The text in these entries is as follows:

23 - Cola
24 - Soda Water
54 - Apple Juice
67 - Orange Juice
100 Undefined

If an undefined value is entered (e.g. 97) then “************” is shown.  If a default entry has been selected,
i.e., 100 (any number can be used), then the text corresponding to 100, “Undefined” is displayed.
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4.11 Clock Calendar

This section describes the Clock Calendar function available in the TIU.  Use the instructions as follows to
embed Clock Calendar.

If the TIU has been fitted with the real-time clock feature, then the time and/or date can be embedded as
data.  To embed the time and/or date:

1. Select Clock Calendar under embedded data list.

Figure 4.16 – Configure Clock Calendar Data

2. Choose the Format of the time and/or date to be displayed on the TIU. Click OK.

4.11.1 Clock Calendar Mapping
It is also possible to map the clock calendar (time and date) information to the automation equipment.  To
do this:
1. From Configure, chose Clock Calendar Mapping.
2. Click Enable.  Select the Data Type (register or other) and first register (or other) for the Map Start.

Click OK.
3. The mapping is displayed in the Map field (see Figure 4.14).
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Figure 4.17 – Clock Calendar Mapping

4.12 Graphing (Not available with the HE500TIU050)

This section describes the Graphing function available in the TIU.  Use the instructions as follows to
embed Graphing.

This features graphs up to two plots of 21 contiguous registers.  Plot 1 is the lower byte of the register
and plot 2 is the upper byte of the register.  The graph is updated continuously.  The actual update time
depends on the equipment connected to the TIU, and communication speed.  The data structure is as
follows:

Offset +0 Offset +1 Offset +2 .   .   . Offset +21
Points Data 1 Data 2 .   .   . Data 21

Points HIGH Byte = Number of point for plot 2
LOW Byte = Number of points for plot 1
Definitions: 0 = do not plot;

1 = plot first 11 registers on X-axis using 10 pixels per register;
2 = plot 21 registers on X-axis using 5 pixels per register;
>2 = assume 2.

Data HIGH Byte = Data for plot 2, ploted with a dotted line
LOW Byte = Data for plot 1, plotted with a solid line
The scale of the Y-axis is 0 to 29.  Values greater than 29 or negative values are plotted full
scale.

4.12.1 To Embed a Graph:
1. Select Embedded Data from the Edit menu
2. Select Graph under Type.
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Figure 4.18 – Graph Embedded Data Formatting

4.12.2 Remote Data Source
Select where the source of the date to be used is. This can either be a register within the connected AE
or an internal register. Drop down the data type box to select the register type to be used and specify the
register number in Location. Where AE Network mode has been selected the PLC node ID from which
this variable should be obtained can be specified in node ID.

4.12.3 Display Format

4.12.4 Range
(Where applicable) Select the values that specify the range over which data will be plotted

4.12.5 Enable Axes
When this option is selected the X and Y-axes of the Graph is displayed on the TIU (except TIU050)
when the project is downloaded.

Note: The graph uses up 3/4 of a menu or submenu page and as such overwrites whatever data is on
that page.
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4.13 Trending (Not available with the HE500TIU050)

This section describes the Trending function available in the TIU.  Use the instructions as follows to
embed Trending.

This features continuously plots up to two registers (channels) versus time. The maximum update rate
depends on the equipment connected to the TIU, and communication speed.

Figure 4.19 Embedding A Trend

4.13.1 Remote Data Source
Select where the source of the date to be used is. This can either be a register within the connected AE
or an internal register. Drop down the data type box to select the register type to be used and specify the
register number in Location. Where AE Network mode has been selected the PLC node ID from which
this variable should be obtained can be specified in node ID.

4.13.2 Data Indirectly Specified.
This option allows the programmer to indirectly specify the register which contains the data for the trend,
i.e. the contents of the register, which is specified in the Location section of the Remote Data Source,
specifies the register that contains the data for the trend.
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4.13.3 Control Data from Remote Device
This option allows the programmer to control the set-up of the trend from registers stored in the
automation equipment. The structure for setting up the trend is described further in this paragraph.

The data structure is as follows:

Offset +0 Offset +1 Offset +2 Offset +3 Offset +4 Offset +5
Time Base Ch. 1 Scale Ch. 1 Data Ch. 2 Scale Ch. 2 Data Width

Time Base 0 = maximum update rate;
1 = 1/10s per plot
X = X/10s per plot, up to X=10

Scale Maximum value of Y-axis for that channel; if 0 channel is not plotted.

Data Raw register values.  Negative values are plotted at full scale.

Width Number of samples across the display
100 = 1 pixel per plot
50 = 2 pixels per plot
25 = 4 pixels per plot
10 = 10 pixels per plot
Any other value, the nearest to the above 4 is used.

If the Control Data from Remote Device option is not clicked then the trend is set-up as follows.

The Time Base is set by the Trend Width.
The scale is set by the Minimum and Maximum Range
The data for the first trace is taken from the register specified or indirectly specified in the Location field
The data for the second trace is taken from the following register specified or indirectly specified in the
Location field.

Note: When Control Data from Remote Device is selected, the data to set-up the structure of the trend is
only read once, when you first go onto a screen where the trend is embedded.  The data for the trend is
read continuously.

4.13.4 Enable Axes
When this option is selected the X and Y-axes of the Trend are when the project is downloaded.

Note: The trend uses up 3/4 of a menu or submenu page and as such overwrites whatever data is on that
page.
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4.14 Menu Timeout

4.14.1 Scope
This section describes the Menu Timeout function available in the TIU.  Use the instructions as follows to
embed Menu Timeout.

The Menu Timeout is a useful safety feature.  This forces the TIU back to the first (main) menu page after
a set time period.  For example, the TIU is on an input menu page, after 30 seconds of no activity, the TIU
reverts back to the non-input (safety) main menu page.  To set the timeout:

From the configuration menu, se
sub-menu pages. Time-outs in e
function, set the time to 0 second

4.15 Flashing Character

4.15.1 Scope
This section describes the Flash
follows to embed Flashing Chara

The user may have flashing char
different ways that flashing chara
a. In the embedded data scree
b. The other way to create flash

Flashing is toggled by line us
line flashes.

Note: Flashing can not be enabl

4.16 Set the Real-time C

4.16.1 Scope
This section describes the Set th
follows to embed Set the Real-tim

The Real-time Clock is not a stan
To automatically set the Real-tim
Connect the TIU to the PC.
From File, choose Set Clock.  Th

4.17 Scaling
This section describes the Scalin
Scaling.

Embedded Fields can be Scaled

x
Figure 4.20 – Set Menu Timeout Bo
lect Configure, then Menu Timeout.  A timeout is set in ALL menu and
ach screen may be inhibited from the Edit menu. To disable the Timeout
s.

s

ing Characters function available in the TIU.  Use the instructions as
cters.

acters on any line and on any type of page in the project. There are two
cters are implemented.

n, under Attributes check the box for Flashing.
ing characters is to use the “TAB” key when you are creating the project.
ing the “TAB” key (current line the cursor is on). In this case, the entire

ed or disabled conditionally.

lock

e Real-time Clock function available in the TIU.  Use the instructions as
e Clock.

dard feature on all TIU’s. The Real-time Clock is set from the PC’s clock.
e Clock from the PC’s clock:

e PC's time is downloaded to the Unit

g function available in the TIU.  Use the instructions as follows to embed

 to convert register values from the AE into real-world numbers.
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4.17.1 To enable Scaling:
1. From the Embedded Data screen, click Enable in the Scaling box.
2. Enter the TIU Minimum, TIU Maximum, Remote Minimum and Remote Maximum.
3. After configuring any other fields, click OK.

The TIU Minimum and Maximum refer to the minimum and maximum values to be displayed on the TIU.
The Remote Minimum and Maximum refer to the minimum and maximum values produced by the AE.

Example.  Scaling can be used to convert the drive speed in RPM to a conveyor's speed in m/min. This
scaling could then be taking the gearbox and all the other mechanical factors into account.  The
maximum speed of the drive may be 1450, but the actual maximum speed of the conveyor is 100 m/min.
Therefore, the Scaling configuration is as follows:
TIU Minimum 0 (m/min)
TIU Maximum 100 (m/min)
Remote Minimum 0 (RPM)
Remote Maximum 1450 (RPM)
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4.18 Page Wizard

4.18.1 Scope
This section describes the Page Wizard function available in the TIU.  Use the instructions as follows to
embed Page Wizard.

The Page Wizard is a short cut for building pages to set or view the internal real-time clock or view
communication statistics.
NOTE: Only available on Text type pages.

4.18.2 To use the Page Wizard:

1. Move to or insert a page that is to be built.
2. Click the Page Wizard icon or from Configure, choose Page Wizard.
3. Click on the Page Type to be built and chose the particular Parameters to be displayed on the TIU.

Click Build Page.

Figure 4.21 – Page Wizard
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CHAPTER 5  THE KEYBOARD

5.1 Function Keys
The TIU support function keys to be assigned in the project. The Up, Down, Pause and Enter
(TIU050/10x/11x/20x) keys can be configured as function keys however are defined on a per page basis.
Due to the fact that the keys may have other functions allocated to them the following restrictions are
placed on the allocation of functions to these keys:

1. The Pause key is available for mapping on status pages, alarm pages, and menu pages with no
editable embedded data, and which are not part of a submenu, and which do not have a submenu.

2. The Enter key is available for mapping on status pages, alarm pages and menu pages, except the
first menu page.

3. The Down Key is available for mapping on status pages and on the last page of a sub menu.
4. The Up Key is available for mapping on status pages and on the first page of a sub menu. (It is used

for scrolling purposes on menu pages that are not the first in a submenu, and on alarm pages.)

The Up, Down, Pause and Enter keys, the alphanumeric keypad on the HE500TIU050/11X/20X and the
System to F5 or F7 Keys on the TIU3xx, TIU41x/51x/61x and TIU42x/52x/62x can also be assigned
functions in the CBREEZE software. These function keys can be programmed on all page types and
menus.

The Configure Function Key Screen lists the available function keys on each page. See Figure
5.1.

Figure 5.1 Configure Function Keys for the HE500TIU11X
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Double Click on the key to be programmed. Each key maybe programmed as a Global or Local function
key. Programmed as a Local function, the key will only complete the function in the present page only.
Programmed as a Global function, the key will perform the function on every page of the project,
provided it is not overridden on a particular page with a local function.

Note: The Up, Down, Pause and Enter keys can only be programmed as Local Function Keys.

The Key Actions for both Local and Global are:
1. Disabled
2. Push Button
3. Preset Register
4. Display Page
5. Ramp Register
6. Set Bit
7. Clear Bit
8. Invert Bit
9. Execute Maths
10. Print Report

Figure 5.2 Function Key Definition

1. Disabled
Default setting, change to any other of the setting to enable function key.

2. Push Button
Sets the register chosen in the Location and Set Data type to the value in the Value field while the
button is pressed. The register is reset when the button is released.

3. Preset Register.
Sets the register chosen in the Location and Set Data type to the value in the Value field.

4. Display Page
Displays the specified page in the Page Number field.
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5. Ramp Register
Increases the value of the Data Type or register type specified under the Location field by the value
entered in the Value field.

6. Set Bit
Sets the bit specified in the Bit field of the Location, of the Data Type or register type to “1”.

7. Clear Bit
Sets the bit specified in the Bit field of the Location, of the Data Type or register type to “0”.

8. Invert Bit
Toggles the bit specified in the Bit field of the Location, of the Data Type or register type.

9. Execute Maths
Executes mathematic function beginning at the specified line number.

10. Print Report
If Reports are configured (see Chapter 12) prints the specified report (1-48)

5.2 Key Mapping
The keyboard can be mapped to PLC automation equipment along with the currently displayed page
number.  This enables keys to be used in Jog/Instantaneous action modes.  Sending the page number
allows the automation equipment to qualify the key states sent to ensure that the function only operates
on the correct page.  The page number is written to the specified data register, Page Mapping, and the
keys are mapped into the next contiguous data register, Key Mapping.

5.2.1 To enable key mapping:
1. From the Configure menu, select Keyboard Mapping.
2. Check the Enable box.
3. Choose the Register Type and the Map Page To Register.  Click OK.

The Configure Key Mapping screen displays the data type, the active page number (from which the
keys are active) and the keyboard mapping bits.

Figure 5.3 - Configure Keyboard Mapping Box
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5.3 Function Key LEDs on HE500TIU20X

Function Key F9 – F18 have corresponding LEDs above or below the function key, indicating if the
function is programmed or not. These LEDs light up when the corresponding Function Key is
programmed to execute a function. When the function key is programmed as a Global Function Key then
the LED is lit up constant as the user goes through the programmed menu screens, on the terminal.
When the function key is programmed as a Local Function Key then the corresponding LED is only lit
when the page in which the local function is programmed is displayed on the terminal.
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CHAPTER 6   RECIPES

6.1 Scope
Recipes allow the user to send or update multiple registers simultaneously.  For example, it may be
desired to run a motor at two different settings for two different applications.

a. Speed of 1000RPM, minimum frequency of 500Hz, acceleration rate of 1000 s/100Hz and
deceleration rate of 2000 s/100Hz;

b. Speed of 500RPM minimum frequency of 400Hz, acceleration rate of 500-s/100Hz and deceleration
rate of 1500 s/100Hz.

Recipes enable the user to download all the fields (four in this example) at the same time without editing
each individual field.

A maximum of 63 fields and 1024 records are supported by the database. The total storage available to
the database is 64 kBytes. The number of bytes currently in use can be obtained from the main
CBREEZE help menu under About CBREEZE.

6.2 Using Recipes
1. From Configure, select Recipes.  Enter the Recipe Name, Number of Records in the Database

and Number of Fields in Record.  The number of Records and Fields can be changed later.  Click
OK.

2. The TIU Recipe Editor appears.  Set the number of Records (different settings) and Fields
(parameters).

3. Edit the Fields and Records as desired.

4. To Add a new recipe database, select File/New Recipe or click on the Add Recipe Icon  on the
toolbar

5. To Delete a recipe database, select File/Delete Recipe or click on the Delete Recipe Icon  on the
toolbar

6. If Multiple Recipes are available these can be scrolled through using File/Next Recipe, File Previous

Recipe or using the Forward and Back icons  on the toolbar

7. From File, select Exit to leave the Recipe Editor.
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6.3 To Edit Recipe Fields and Records

1. Open the Recipe Editor by clicking on the Recipe icon  on the Toolbar or from
Configure/Recipes.

2. Left click on the Field to be edited.  Enter the Ingredient Name, Type, Remote Data Source and
Format in the same manner as Embedded Data. Enable Scaling if desired.

3. Left click on the Record to be edited.  Enter the value and click OK or press <Enter>.
4. From File, select Exit to leave the Recipe Editor.

6.4 Editing Ingredient Properties
An ingredient, or field, in the database corresponds to a value which will be loaded to a specified location
either internal to the TIU or in the connected automation equipment.

Each field has the following properties: -

6.4.1 Ingredient name
An alphanumeric string that is used to specify which field in a recipe is being edited. The string may be up
to 30 characters in length.

6.4.2 Type
Currently recipe data fields may be formatted as numeric, timer, alphanumeric or bit.

Figure 6.2: - Ingredient Properties
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6.4.3 Remote Data Source
Select where the source of the date to be used is. This can either be a register within the connected AE
or an internal register. Drop down the data type box to select the register type to be used and specify the
register number in Location. Where AE Network mode has been selected the PLC node ID from which
this variable should be obtained can be specified in node ID.

6.4.4 Format
Additional data to specify the format of the data field dependant on its type.

6.4.5 Range Checking
Allows the range of values entered by the operator to be restricted to be within a minimum and maximum
value.

6.4.6 Scaling
Use scaling settings where the values read from the PLC need to undergo a conversion prior to being
displayed on the PLC. Refer to the Numeric and Timer embedded data editing sections (4.1 and 4.3) for
details of scaling usage.

6.5 Editing Recipe Data
Double click on the field to be edited. If the data is a bit status it will toggle, otherwise the Edit Data dialog
box will appear. Enter the new data for the field and press enter or click OK.

Enter the data required for the field

6.6 Renaming Records
Double click on the record name. When the enter record dialog box is displayed enter the new record
name, and click OK or press Enter.

NOTE:
While there is no limitation on the number of recipes created, the Recipe Database is limited to 64Kbytes.
The Recipe Database size can be viewed from Help/About Cbreeze/ Recipe Bytes Allocated.

Figure 6.4 – Record Name

Figure 6.3: - Edit Data
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6.7 To Embed a Recipe on a Menu Page
When embedding a recipe item on a menu page the following box is displayed.

Figure 6.5 – Embedded Recipe Item

The three format types are

6.7.1 Recipe Selector
The Recipe Selector field allows the user to select a recipe database.
The recipe selector requires a field to be selected from the database, typically this will simply be the
record name.
The recipe selector initially displays the contents of the specified field within the first record in the
database. The operator will be able to scroll through the records in the database to select the record on
which he wants to operate. When the required record is found, the Enter key is pressed and the desired
record is selected.
The recipe selector is used either on it’s own, in which case the page is a recipe selection page and upon
selecting the record the contents of that record are transferred to the TIU internal registers and/or the
automation equipment. Otherwise the recipe selector is used in conjunction with a recipe field tag and a
recipe field contents embedded data field, in which case the page is a recipe editing page used to modify
the values loaded by the specified record when selected.

• Recipe Name will allow the user to edit the contents of each Item of the displayed Record; the
Record name will be displayed.

• If one of the Items is selected then the user can edit the contents of each Item of the displayed
Record; the Record number will be displayed.

6.7.2 Recipe Field Tag
If the Recipe Field Tag is embedded on the menu page then the Item Name of the record selected for that
menu page will be displayed. The recipe field embedded data must always be used in conjunction with
both a recipe selector and recipe field contents embedded field. If all three recipe embedded data types
are on screen the page is used for editing a recipe. Initially when a page is displayed the recipe field tag
will be blank. It remains blank until a recipe has been selected using a recipe selector field. At this point
the first recipe field is selected for editing and the name of this field is displayed as the recipe field tag. As
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the operator enters each recipe item, the recipe field tag moves on to the next field tag until all fields in
the recipe have been modified or accepted.

6.7.3 Recipe Field Contents
If the Recipe Field Contents is embedded on the menu page then the contents of the current Item, of the
record selected for that menu page, will be displayed. The recipe field contents embedded data must
always be used in conjunction with both a recipe selector and recipe field tag embedded field. If all three
recipe embedded data types are on screen the page is used for editing a recipe. Initially when a page is
displayed the recipe field tag will be blank. It remains blank until a recipe has been selected using a
recipe selector field. At this point the first recipe field is selected for editing and the name of this field is
displayed as the recipe field contents. Once all the fields in the record have been accepted the modified
record is written to flash memory in the terminal. Note that to send the contents of the newly modified
record to the automation equipment and/or the TIU internal registers the operator must call up a recipe
selection page and select it in the normal manner.
Pressing the pause key at any point during the editing sequence will abort data editing, and cause any
changes to the recipe data already made to be ignored. The flash memory is only updated if all fields are
accepted with the Enter Key.
Because of the precise nature of the combinations in which the recipe embedded fields must be used in
order to achieve a specified function it is recommended that the page wizard is always used to build
recipe operation pages!

Note: A recipe item can be manually embedded on a menu page however for best results when
embedding a recipe item on a screen see the Page Menu Wizard for Recipe Items. This can always be
edited afterwards.

6.8 Importing and Exporting Data from a Recipe
Recipe tables can be imported or exported.  Files can be imported or exported as coma delimited (*.csv)
or as print files (*.prn).  Other file types may be viewed but may not load properly.

Note: Only Records are exported and imported, the Field names are not.

Note: If the table size that the data has been imported into is smaller then the table it was imported from,
then not all of the data is displayed.

Note: Only one Record column can be selected per project at any time.
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CHAPTER 7  TUTORIAL

7.1 Scope
This chapter contains instructions for using several of the HE500TIU050/100/110 features.  The projects
in this chapter serve as examples and are not to be taken literally for all applications.  After following this
tutorial, the user should have a better understanding of how the HE500TIU050/100/110 operates.

7.2 Menus
The HE500TIU050/100/110 supports a total of 300 pages divided between menu and sub-menu, alarm
and status pages.  The following points are covered in this section:

1. Menus can have sub-menus.
2. Sub-menus can have sub-menus.
3. There may be up to 8 embedded data per page.
4. Embedded data can be displayed-type or entry/editing-type.
5. Sub-menus can be password protected.

Additional menu pages may be created by selecting Insert Page from the Edit menu or by selecting the
“+” icon from the icon menu to the right of the Display screen.  Selecting Delete Page from the Edit menu
or by selecting the “-“ icon will delete the displayed page.

The next menu page may be selected by clicking the “Down” key or by selecting the Next Page from the
Goto menu.  The previous menu page may be selected by clicking the “Up” key or by selecting Previous
Page from the Goto menu.

Example:  The HE500TIU050/100/110 is used to monitor the temperature of a furnace and indicate the
heater or a fan is ON or OFF.  This example uses a Hitachi H-252 series PLC, but is applicable to any
PLC with modifications.
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1. Communication Settings from Configure.  Select the applicable automation equipment being
used, in this example a Hitachi H-series is used.  Click OK.  Update the Protocol if required

2. Menu Page 1 shows some explanatory details about the program and should look like figure 7.1.
For “Furnace Control #1” on line 3, click on the font double height icon at the beginning of the
line.

3. Click on the Insert Page Icon.  Choose Insert After Current Page.  Click OK.

Figure 7.1 – Menu Page 1
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Figure 7.2 – Menu Page 2

Figure 7.3 – Menu Page 2
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1. Enter the text as shown in Figure 7.2.
2. Place the cursor one space to the right of “Temperature” and embed a Numeric Data in WR-

REGISTERS Location 10.  Select “XXX”, 16-Bit, Unsigned.  Click OK.  Correct “C” position.
3. On the first space of the fourth line, click the embed icon.  Choose Analog Meter, WR-

REGISTERS and Location 3.  Under Format, enter 15 for characters, 760 for Maximum and 0
for Minimum.  Click OK.

4. Place the cursor 6 space to the right of “Heater” and embed a Bit Status in Y-REGISTERS,
Location 100, Select Token Pair Format, “OFF”/”ON.”  Click OK.

5. Place the cursor 9 spaces to the right of “Fan” and embed a Bit Status in WR-REGISTERS,
Register 10, Select Token Pair Format, “OFF”/”ONFF”, Bit Number 1. Click OK.

6. After embedding the data, the screen looks like Figure 7.3.

Under the File menu, click Download Project.

The temperature is displayed digitally and as a bar graph by the horizontal fill.  Also, it is shown whether
the heater and fan are ON or OFF.

Note: For this example to work a thermocouple and relay module must be used to simulate temperature,
heater and fan.  Otherwise the latent values displayed will be blank or the values in the PLC registers.

7.1 Sub-Menus
Sub-menu pages branch off menu pages analogous to a sub-directory branching off a main directory of a
PC.  The HE500TIU050/100/110 supports a total of 300 pages divided between menu and sub-menu,
alarm and status pages.

Example:  Continuing from the example in Figure 7.2, one sub-menu is set up for the heater and one for
the fan.  Each sub-menu sets the temperature (within the furnace) at which the heater or fan turns
ON/OFF.

Note: Ladder code needs to be written if this example is to work as anything more than an example.

1. Go to menu page 2.  Under the Create SubMenu page, choose 2 for the Number of Pages.  Be
sure that the Password Protect box is unchecked.  Click OK.  The bottom middle cell should
display Menu Page 2.1 (indicating a sub-menu).

2. After completing this, enter the text as shown on the first sub-menu page (as follows):
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3. Embed data one space to the right of “ON Temperature” by selecting Numeric for the Type, WR-
REGISTERS for the Data Type and Location 10.  Under Format, select “XXX”, 16-Bit
Unsigned and click on Edit Enable.  Click OK.

4. Do the same as in step 3 for “OFF Temperature” but use Location 11.
5. On the sixth line, one space to the right of “Manual Override” embed a Bit Status in WR-

REGISTERS, Register 10, Select Token Pair Format, “OFF”/”ON”, Bit Number 1, Click on Edit
Enable. Click OK.

Figure 7.4 – Sub-Menu Page 2.1
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7.3 Password-Protected Sub-Menus
Scope
This tutorial section of the manual covers how to create password-protected sub-menus.

Example: Continuing from the example in 7.2, one sub-menu is set up for the heater and another for the
fan.  Each sub-menu sets the temperature (within the furnace) at which the heater or fan turns ON/OFF.
This is the same as the example in 7.3 except that the sub-menus are now password protected.

1. Create a new menu page by selecting Insert Page from the Edit menu.
2. Enter the text, as shown in Figure 7.6.

3. Place the cursor one space to the right of “CODE” and select Embedded Data from the Edit
menu.  Select Password for the Type.  Click OK.  Four question marks should appear beside the
word “CODE”.

4. Go to menu page 3.  Select the Modify SubMenu Properties, and choose 2 for the Number of
Pages Check the Password Protect box, and enter a Password of “1234”.  Click OK.  The
bottom middle cell should display Menu Page 3.1 (indicating a sub-menu).

5. Follow steps 2 through 8 in 9.3.
6. Save and Download Project to the HE500TIU050/100/110.

Figure 7.6 - Password Enter Screen
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The resulting display screen on the HE500TIU050/100/110 appears as the screen shown in Figure 7.7
(with a code of 0000).

To Enter the Sub-Menu:
1. Press the Pause key to edit the Pass Code.
2. Press the Up key to increment the code, 1234 in this example (hold the key down for speed

incrementing), the Down key to decrement the data and the Enter key to enter the data.
3. Press the Pause key and the Down key at the same time to select the sub-menu page.  The sub-

menu page is only selected if the Pass Code is correct.

To Edit The data On The Sub-Menu Pages:
1. Press the Pause key to select the field to edit.
2. Press the Up key to toggle or increment the field.  Press the Down key to toddle or decrement

the field.  Press the Enter key to send the value to the PLC.
3. Press the Pause key to select the next field to edit.
4. Press the Pause key and the Up key at the same time to return to the parent menu.

Figure 7.7 - Password Enter Screen
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7.4 Status
Scope
The TIU can display STATUS information.  For example, a status page can be displayed as COILS
change (in real-time) in your PLC, i.e., the first Coil displays the first Status page, the second coil the
second page and so on.

Status messages can have up to eight embedded data values per page.  Up to 300 total pages are
available split between Status, Alarms and Menu pages.

Two different modes are available for configuring status pages.  These modes are the Bit Mode and the
Direct Mode.

• Direct Mode reads only one register as a word from the PLC for the status page.  If the value in
this register is zero or greater than the number of configured status pages in the system, the
main menu screen is displayed.  Otherwise, the appropriate status screen is called up.

• Bit Mode works essentially the same, except that the screens are controlled by discrete bits
instead of the full word register values.

NOTE: Status pages are only displayed when MENU PAGE 1 is selected.

Example:  The following example involves the TIU connected to a GE Fanuc 90-30 PLC.  It is applicable
to any of the supported automation equipment (see 7.3) with substitutions made for the specific
registering nomenclature, i.e., %Q is a discrete bit output.  It is assumed the PLC is properly configured,
the TIU is properly connected to the PLC, both are powered up, and the CBREEZE software,
HE500TSW232, is running on the PC.

1. Select Communication Settings from the Configure menu.  Select the automation equipment
type you are using.  For the example here, a “GE Series 90 SNP protocol” is being used. Click
OK.

2. Insert a menu page after Menu Page 1 (refer to 7.2 for instructions).  Place the cursor at the left
on the first line.  Click the double height icon.  Type “Discrete Outputs:”

3. On the third line, type “Q1:”.  Click on the Embed Icon.  Select Bit Status from Type; discrete
output (in this example %Q) from Data Type; Location 1; leave Token Pair as “OFF”/”ON” and
click Edit Enable. Click OK.  See Figure 7.8.

4. Do the same for Q2, Q3 and Q4 on lines 4, 5 and 6, incrementing the Bit Number by one.  These
discrete outputs will simulate coils.  Menu Page 2(2) should be the same as Figure 7.9.
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Figure 7.9 – Menu Page 2(2)

Figure 7.8 – Configure Embedded Data Box
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From Configure, choose Status.  Click Direct Mode.  From Data Type choose discrete output (%Q in
this example); Block Start equals1.  The Number of Status Pages equals 4. Click OK.

From View, choose Status.  This displays the first of four status pages.  On the third line, delete what is
there and type “Status Page:” on the fourth line, click on the x4 icon and type “1” in the centre of the line.
Status Page 1 appears as the screen in Figure 7.11.  Highlight display screen,
click Edit and Copy.

Figure 7.10 – Configure Status Pages

Figure 7.11 – Configure Status Pages
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Click the down arrow icon on the project software to get to Status Page 2 of 4.  Delete what is on the
display screen, then from Edit, choose Paste Page.  Change the “1” on line four to a “2.”  Do the same
for pages 3 and 4.

From File, choose Download Project

On the TIU, press the DOWN key to get to the Discrete Output page (as in Figure 7.8).  Press the PAUSE
key the toggle Q0: ON by pressing the UP key and ENTER key.  Press the PAUSE key until nothing is
highlighted (three times).

Press the UP key.  The page shown in Figure 7.12 should be displayed.

Note: Status pages are only displayed from Menu Page 1.

5. Press the DOWN key and return to the Discrete Outputs page.  Toggle Q1:OFF and Q3:ON.
Return to Menu Page 1 by pressing the UP key.  Now Status Page 4 is displayed.  This is
because Direct Mode is selected and the register is being read as a word, i.e., 0100 binary = 4.

6. Toggle Q1: ON, Q2: ON, Q3: OFF and Q4: OFF.  Now Status screen 3 is displayed (0110B=3).
7. Toggle Q4: ON and all the other OFF.  Now a screen with “Default Menu Screen” written on the

second line is displayed.  The HE500TIU050/100/110 is looking for Status Page 8 (1000B = 8),
which does not exist, so the default screen is displayed.

8. In the CBREEZE software, choose Status from Configure.  Click on Bit Mode.  Click OK.
Download the project to the HE500TIU050/100/110.

9. Now Status Page 4 is displayed.  In Bit Mode, the HE500TIU050/100/110 reads the register as
discrete bits, not as a word, i.e., 1000 triggers Status Page 4, 0100 triggers Status Page 3, etc.

Figure 7.12 – Status Page 0
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7.5 Alarms
7.1.2 Scope
The HE500TIU050/100/110 can display ALARM information as BITS change in your PLC (real-time).  The
active alarms can be accepted and then SCROLLED through. Up to 300 total pages are available split
between Alarms, Status and Menu pages.

The HE500TIU050/100/110 also has an Alarm Acknowledge Table.  This feature allows a set of bits to be
written back to the PLC to indicate alarms that have been accepted by the user, but are still “ON” in the
PLC table.  These bits are in the same format as the “incoming” alarm bits.  The acknowledgement bits
are set when an alarm has been acknowledged, provided that the corresponding bit is still active in the
alarm table.  The acknowledgement bit is cleared when the corresponding alarm bit is cleared.  Click the
Enable box to use the Alarm Acknowledge Table.

Example:  The HE500TIU100 or 110 is connected to a GE Fanuc 90-30 PLC.  Register %R20, bits 1, 2,
3 and 4 are the alarms.  Register %R21, bits 1, 2, 3 and 4 is the acknowledgement table.  The
instructions below are a tutorial of how to use the Alarms on the HE500TIU050/100/110.

1. Select Alarms from the Configure menu.

2. Set the Data Type to %R.  Enter the location of the Block Start as 20.
3. Enter the number of alarm pages in the Number Of Alarms box (4 for example).  If the number

of alarms is greater than 16, then the next PLC register is read.
4. Check the Acknowledgement Table Enable box.  Set Data Type to %R and Block Start to 21.

Click OK.
5. Insert a page (Page 2) after Page 1.  Go to page 2.  On the second line type “Alarm:” and embed

%R20 beside.  Make the embedded %R20 field Numeric, two digits and Edit Enabled with a
Range Maximum of 15.  This field acts as the alarms.

6. On the fourth line, type “Acknwldg Table:” and embed %R21 beside. Make the embedded %R22
field Numeric and two digits.  This field holds the Acknowledgement table.

Figure 7.13 – Configure Alarm Box
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7. Select Alarms from the View menu.  The bar at the bottom displays the alarm page selected.

The next alarm page can be selected by clicking the Down key or by selecting Next Page from the Goto
menu.  The previous alarm page can be selected by clicking the Up key or by selecting Previous Page
from the Goto menu.

8. Enter text in Figure 7.14.

9. Place the cursor beside either “ACCEPTED” OR “UNACCEPTED” and select Embedded Data
from the Edit menu or click the embedded data icon (X.X).

10. Select System Variable under Type and XXX Accepted Alarms or XXX Unaccepted Alarms
under Select System Variable in the Format section.

11. Block the entire page.  From the Edit menu, select Copy (or type <Ctrl-C>).
12. Page down to Alarm Page 2 of 4 using Next Page from the Goto menu.  Paste Page 1 to Page 2

using Paste from the Edit menu (or <Ctrl-V>).  Do the same for alarm page 3 and 4.

Figure 7.14 - Alarm Page 1 Screen
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13. Download Project to the HE500TIU050/100/110.  Put your PLC in “RUN” mode.

On the HE500TIU050/100/110:

Scenario 1: energise alarm 1.  Go to page 2.  Select the field beside “Alarm” by pressing the Pause key.
Change the value to 1 and press the Enter key.

Action: Alarm Page 1 is displayed.  The user presses Enter. The alarm page goes away and “Acknwldg
Table:” (%R21) equals 1 indicating alarm 1 has been acknowledged.

Scenario 2: energise alarm 3.  One page 2, change the Alarm field to 0, press Enter.  The “Acknwldg
Table:” field returns to 0 as well.  Set the “Alarm” field to 4 (the HE500TIU050/100/110 read discrete bits
for the alarms, so 0100 binary, i.e., bit 3 high equals 4 decimal).

Action: Alarm Page 3 is displayed.  The user presses Enter. The alarm page goes away and “Acknwldg
Table:” (%R21) equals 4 (i.e., bit 3 is high) indicating alarm 3 has been acknowledged.

Scenario 3: energise alarms 1, 2 and 3.  One page 2, change the Alarm field to 0, press Enter.  The
“Acknwldg Table:” field returns to 0 as well.  Set the “Alarm” field to 7 (the HE500TIU050/100/110 read
discrete bits for the alarms, so 0111 binary equals 7 decimal).

Action:
a. Alarm pages 1, 2 and 3 are active.  Alarm page 1 is displayed as the first alarm.  Until any alarms are

accepted, the Alarms Accepted reads 000 and the Alarms Unaccepted reads 003.

b. The next Active alarm page can be selected by pressing the Down key on the
HE500TIU050/100/110.  The last Active alarm can be selected by pressing the Up key on the
HE500TIU050/100/110.

c. The Active Unaccepted Alarms can be accepted by pressing the Enter key on the
HE500TIU050/100/110.  Only one alarm is accepted at a time.  Once an alarm is accepted, the next
alarm is displayed.  Accept all 3 alarms.

Go to page 1.  Accepted Active Alarms can be recalled by pressing the Enter key.  Accepted Active
Alarms are scrolled through with the Up key and the Down keys on the HE500TIU050/100/110.
Pressing the Enter key again returns display to page 1.

Note: Active Unaccepted alarms are displayed as a priority on any page.
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CHAPTER 8  GRAPHIC EDITOR

8.1 Scope
The TIU Graphic editor is designed to be a simple Drawing and Graphic Editor to be used with the
HE500TIU20X/HE500TIU3XX/HE500TIU4XX/HE500TIU5XX/HE500TIU6XX. Terminals in these ranges
support 2 types of pages, a Text Page and a Graphic Page. The text page works similarly to the menu
pages on the HE500TIU10X/11X. Graphic pages, as well as all the features of the text page, also support
many other graphical features, such as; Shapes, vertical text, bit maps and bit map animation.
All features are designed to be intuitive to the experienced user of Windows™ type applications. The
following paragraphs describe most of the features available, however hopefully the user will find the
software easy to use with some experimentation.

8.2 Draw Mode
Select a drawing mode by clicking on the appropriate button on the Shapes Toolbar, by choosing
Setting/Draw Mode from the main menu. Before drawing the object choose the Background Fill (this
maybe changed afterwards).

Figure 8.1 – The Shapes Toolbar

8.2.1 Selector

The selector tool may be used to select objects or groups of objects already created. Select an object by
clicking on any part of the object. Set the properties of an object by double clicking on the object.
To select all objects click Edit/Select All.

8.2.2 Rectangle

1. Select Rectangle Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired rectangle. Click and hold the left mouse button.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The Draw Mode returns to Selector as default
6. To edit the size of the rectangle click on the object, then click on one of the black dots around the

object. Drag this dot around on the screen and the rectangle will change size automatically.
7. Double click on the added rectangle to modify its’ colour. The select shape attributes applicable to the

terminal type in use will be displayed, which will be similar in format to the figure 8.2
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Figure 8.2 – Select Shape Attributes TIU31X/TIU32X

Figure 8.3 Select Shape Attributes TIU4XX/TIU5XX/TIU6XX

8.2.2.1 Pen
Select the colour that is to be used to draw the outline of the rectangle by clicking on one of the pen nib
icons. The indicator at the bottom right of the box will be updated as will the sample rectangle to the top
right of the dialog box.

8.2.2.2 Ink
Select the colour that is to be used to fill the rectangle by clicking on one of the ink pot. The indicator at
the bottom right of the box will be updated as will the sample rectangle to the top right of the dialog box.
Click on the empty ink pot icon at the centre bottom of the box to cause the rectangle not to be filled.
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8.2.2.3 Line Style
Select the line style (Solid/Dashed/Dotted/Dash Dot) to be used to draw the border of the rectangle. If the
selection is solid then the line thinkness (width) may also be selected.

8.2.2.4 Colour control
The Colour Control >>> button is unavailable on the Tiu2XX range. Click on this to allow the shapes
colour to be controlled by the system. Once selected the box is expanded to be as in figure 8.3

Figure 8.3 – Select Shape Attributes with Colour Control

8.2.2.5 Remote Data Source
Select where the source of the date to be used to control the colour of the shape is. This can either be a
register within the connected AE or an internal register. Drop down the data type box to select the register
type to be used and specify the register number in Location. Where AE Network mode has been selected
the PLC node ID from which this variable should be obtained can be specified in node ID.
If auto mask is selected only the relevant bits within the control word to be used.

8.2.2.6 Colours
Click on entries in the colour palette to modify the colours displayed for a particular index. A cross symbol
indicates a transparent shape, hence using the data source register to control visibility of the selected
object.
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8.2.3 Ellipse

1. Select Ellipse Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired ellipse. Click and hold the left mouse button.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The Draw Mode returns to Selector as default
6. To edit the size of the ellipse click on the object, then click on one of the black dots around the

object. Drag this dot around on the screen and the ellipse will change size automatically.

8.2.4 Rectangle Rounded

1. Select Rectangle with Rounded Corners Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired rectangle. Click and hold the left mouse button.
4. The Draw Mode returns to Selector as default
5. To edit the size of the ellipse click on the object, then click on one of the black dots around the

object. Drag this dot around on the screen and the ellipse will change size automatically.

8.2.5 Lines

1. Select Line Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired line. Click and hold the left mouse button.
4. Drag the mouse to where the second point is to be located is to be located.
5. The Draw Mode returns to Selector as default
6. To edit the size of the line and shape click on the object, then click on one of the black dots

around the object. Drag this dot around on the screen and the line will change size automatically.

8.2.6 Arcs

1. Select Arc Draw Mode.
2. Select the background and pen colour.
3. Move to a corner of the desired arc. Click and hold the left mouse button.
4. Drag the mouse to where the opposite corner is to be located.
5. The Draw Mode returns to Selector as default.
6. To edit the size of the arc and shape click on the object, then click on one of the black dots

around the object. Drag this dot around on the screen and the arc will change size automatically.

8.2.7 Bezel Mode

1. Select Bezel Draw Mode.
2. Move to a corner of the desired bezel position Click and hold the left mouse button.
3. Drag the mouse to where the opposite corner is to be located and release the mouse button. The

Draw Mode returns to Selector as default.
4. The following dialog box is displayed...
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Figure 8.4 – Select Bezel Attributes

8.2.7.1 Bezel Style
Select whether the frame will be thin or thick and whether the bezel should appear sunken or raised.

8.2.7.2 Colour
Specify the colour for the bezel

8.2.7.3 Control Raised/Sunken
If enabled, Remote Data Source can be used to specify a bit which will control whether the bezel appears
raised or sunken. This feature is typically used when creating custom touch key areas on the display.

5. To edit the size of a bezel click on the object, then click and hold on one of the black dots around the
object. Drag this dot around on the screen and the bezel will change size automatically.

8.2.8 Text Mode

1. Select Text Mode.
2. The background on text mode is by default transparent (This can be edited later).
3. Click on the screen, this will become the top left-hand corner of the text box.
4. Drag the mouse to where the bottom right hand corner is to be located.
5. The Set Text window opens Enter the required text and colour information(Fig 8.5)
6. The Draw Mode returns to Selector as default
7. To edit the size of the font click on the object, then click on one of the black dots around the

object. Drag this dot around on the screen and the font will change size automatically.
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Figure 8.5 – Set Text (Colour Control Disabled)

Figure 8.6 - Set Text (Colour Control Enabled)

8.2.8.1 Text
Specifies the text that is to be shown on the screen. The text is displayed in the original text area drawn,
in an appropriate size font.

8.2.8.2 Text alignment
Positions the text within the text box.
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8.2.8.3 Text direction
Selects whether the text will be displayed horizontally or vertically

8.2.8.4 Colour Indicator button.
Click on the colour indicator to select the colour in which the text will be drawn.

8.2.8.5 Colour Control>>>
On TIU3XX/TIU4XX/TIU5XX/TIU6XX systems a ‘Colour Control >>>’ button is displayed. Click on this
button if it is required to modify the colour of a text field under control of the system. Clicking on this
button will toggle the dialog box between the two formats as in Figures 8.5 and 8.6.

8.2.8.6 Remote Data Source
Select where the source of the date to be used to control the text colour is. This can either be a register
within the connected AE or an internal register. Drop down the data type box to select the register type to
be used and specify the register number in Location. Where AE Network mode has been selected the
PLC node ID from which this variable should be obtained can be specified in node ID.
If auto mask is selected only the relevant bits within the control word to be used.

8.2.8.7 Colours
Click on entries in the colour palette to modify the colours displayed for a particular index. Text on a pair
of horizontal white background lines indicates a transparent back ground, and a cross symbol indicates
transparent text, hence using the plc register to control visibility of the selected object.

8.2.9 Static Bitmap

1. Select Static Bitmap Mode.
2. Click on the screen, this will become the top left-hand corner of the bitmap area.
3. Drag the mouse to where the bottom right hand corner is to be located. This will also set the size

of the bitmap.
 
 The following Dialog Box will be displayed:
 

 
 

 Static Bitmap Selection Dialog
 
 Select the source of the bitmap which is to be added to the screen
 
 New Bitmap
 Creates a bitmap of the required size and colour depth, and opens the program currently registered as
the bitmap editor for windows (typically paint) so that it may be edited.
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 Import Bitmap
 When selected prompts the user to enter a bitmap file name which is imported in to the current picture
and is resized to the appropriate size and specified colour depth.
 
 Import from Symbol Library
 Automatically opens the CBreeze symbol Library picker which allows the user to select from a vast
database of process oriented symbol bitmaps.
 
 Colour Depth
 Allows the user to force the colour depth of the bitmap which is added. Colour depths which are not
supported by the currently selected Tiu are automatically precluded from the selections available. The
colour depth supported by the currently selected terminal is automatically selected. Note that changing
the initial selection will cause the size of the bitmap stored at the terminal to be reduced, but will cause
the display draw time to be increased as the Tiu changes the format 'on the fly' when the image is initially
drawn.
 
 

8.2.10 Table Mode

This tool allows you to easily draw the lines for a table and enter a Table Header. Once the table is
created the number of rows and columns can not be edited directly. Boxes or lines may be added
manually afterwards.
1. Select Table Mode.
2. Click on the screen, this will become the top left hand corner of the Table
3. Drag the mouse to where the bottom right hand corner is to be located. This sets the size of the table

only.
4. The Table Creation windows open (Fig 8.8)

Figure 8.8 – Table Creation

5. Set the number of columns and rows you require.
6. Click on Add Table Header and enter Table Header Text if required.
7. The 3D effect adds an extra line on the right side of the table to give the effect of shadow.
8. Click OK to create table.
9. The table will then be drawn in the area specified at the beginning.
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10. The Draw Mode returns to Selector as default.

8.2.11 Touch Key Mode

1. Select Touch Key Mode. (Only available on TIU3XX/TIU4XX/TIU5XX/TIU6XX).
2. Move to a corner of the desired touch key position Click and hold the left mouse button.
3. Drag the mouse to where the opposite corner of the touch key area is to be located and release the

left mouse button.
4. The Touch key configuration area dialog box will appear.

Figure 8.9 Set Touch Key

5. Type in the legend which should appear on the touch key in the legend box.
6. Select the type of action which the touch key should perform in the Key action drop down list box
7. Specify additional action parameters.
8. Click on the ‘PUSH ME’ button to modify the colour of the touch key area.
9. The Draw Mode returns to Selector as default.
10. To edit the size of the touch key click on the object, then click and hold on one of the black dots

around the object. Drag this dot around on the screen and the touch key will change size
automatically.

8.2.12 Flood Fill Mode

1. Select Flood Fill Mode. (Only available on TIU3XX/TIU4XX/TIU5XX/TIU6XX).
2. Move to the point of the desired flood fill source. The flood fill will start at the selected point and will

occupy all adjoining points that have the same colour as the flood fill source. Click once, or
alternatively drag and drop a positional rectangle. In the case of the positional rectangle the flood fill
will start from the centre of the rectangle.

3. The Flood fill configuration area dialog box will appear.
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Figure 8.9 Set Flood Fill

8.2.12.1 Remote Data Source
Select where the source of the date to be used to control the flood fill colour is. This can either be a
register within the connected AE or an internal register. Drop down the data type box to select the register
type to be used and specify the register number in Location. Where AE Network mode has been selected
the PLC node ID from which this variable should be obtained can be specified in node ID. Unused bits in
the source register will automatically be ignored.

8.2.12.2 Colours
Click on the boxes within the Colours box to specify the colours that will be displayed for various control
values in the Data Source register.

8.2.12.3 Reset Colours
The Reset Colours button causes a standard palette of colours to be loaded.

4. The Draw Mode returns to Selector as default.

8.2.13 Scribble Pad

The Scribble pad gives the user the means to incorporate an area on the screen that can be drawn into
by the operator using his finger. It is intended as a means for an operator to leave a message for a
colleague perhaps on a subsequent shift.
1. Choose the Scribble Pad embedded data type.
2. Position the mouse at one corner of the area where the pad is to be drawn. Click and hold the left

mouse button.
3. Reposition the mouse to the opposite corner of the pad area and release the left mouse button. The

propertes of the Scribble Pad object are non editable – the object is always displayed in the following
format.
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Figure 8.20 – The Scribble Image
4. It is recommended that the notepad is not placed on screen with other animation objects. Doing so

will degrade the speed of response of the notepad touch screen response.The Scribble Pad

8.3 Palette Toolbars
The palette toolbar displayed for a particular terminal will be dependant on the screen capabilities of the
display fitted to the terminal type.

Note : On TIU30X displays although up to 16 shades of grey are supported the differential between each
is quite small and the use of many different ‘shades’ within a screen, can cause ‘fringing effects’. It is
recommended that when designing screens for the Tiu30X the number of shades used on each individual
screen is kept as low as possible.

Dependant on the terminal type selected a palette toolbar will be available. The toolbar will be one of the
following…

Figure 8.10 - Monochrome Palette (TIU2XX)

Figure 8.11 - Grey Scale Palette (TIU30X)

Figure 8.12 - Colour Palette (TIU31X/ TIU32X/TIU4XX/TIU5XX/TIU6XX)

The Palette tool bars are used to select the pen colours, used for the outlining or detail of an object for
example the text, depicted on the toolbar by a pen nib, and also the background or fill colour of an object,
depicted on the toolbar by an ink pot. To create a transparent object or one with no background the right
most icon (empty ink pot) is selected.
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8.4 Embedding Data on a Graphic Menu Page

8.4.1 Scope
The Embedded Data types are similar to the data types on text menu pages. Where applicable all data
types work the same as they do on a text page see Chapter on Embedded Data. The main difference is
how the data type is embedded on the screen.

Figure 8.13 - Animation Tool bar

To Embed Data on the Screen
1. Choose the Embedded Data type you wish to embed.
2. Click on the screen, this will become the top left hand corner of the area the displayed data will take

up.
3. The normal embedded data type window will appear. Set-up the embedded dat type as required (See

Chapter on Embedded Data).
4. Once the embedded data type is created it is displayed in the area defined earlier, in a font size

appropriate to the size of the area.

8.4.2 Analogue Meter

Similar to the horizontal fill is the “Needle Meter” type Analogue Meter. It is embedded on the menu page
similar to the Horizontal Meter.

To embed an Analog Meter on a graphics screen:

1. Choose the Analogue Meter Data type.
2. Click on the screen, this will become the top left hand corner of the area the displayed data will take

up.
3. The normal horizontal fill embedded data type window will appear. Set-up the embedded data type as

required (See Chapter on Embedded Data).
4. Once the embedded data type is created it is displayed in the area defined earlier.
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8.4.3 Animated Bitmap Selector

1. Choose the Animated Bitmap selector Embedded Data type.
2. Click on the screen, this will become the top left hand corner of the bitmap area.
3. Drag the mouse to where the bottom right hand corner is to be located.
4. The Animated Bitmap Selector data type window will appear (Fig 8.11).

Figure 8.14 – Embedded Animated Bitmap Selector Windows

8.4.3.1 Remote Data Source
Select where the source of the data to be used to control the animated is. This can either be a register
within the connected AE or an internal register. Drop down the data type box to select the register type to
be used and specify the register number in Location. Where AE Network mode has been selected the
PLC node ID from which this variable should be obtained can be specified in node ID.

8.4.3.2 Display Format
Select here the animated bitmap which should be used. To reuse an existing animated bitmap select it
from the drop down box. To create a new animated bitmap select ‘New Animated Bitmap’ and then click
edit table

8.4.3.3 Edit/Write
When checked allows the user to modify the current selection.

8.4.3.4 Attributes
Use attributes to assign any additional attributes to the animated bitmap.
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8.4.4 Lamp

To embed a Lamp on a graphics screen:
1. Choose the Lamp embedded data type.
2. Position the mouse at one corner of the area where the lamp is to be drawn. Click and hold the left

mouse button.
3. Reposition the mouse to the opposite corner of the lamp area and release the left mouse button. The

lamp embedded data type window will appear…

Figure 8.15 - Configure Lamp Embedded Data

8.4.4.1 Remote Data Source
Select where the source of the date to be used to control the shape is. This can either be a register within
the connected AE or an internal register. Drop down the data type box to select the register type to be
used and specify the register number in Location. Where AE Network mode has been selected the PLC
node ID from which this variable should be obtained can be specified in node ID.
This will be a digital point for a single colour lamp or an analog value for a multicolour lamp.

8.4.4.2 Display format
Select whether the lamp is to be displayed as a round or rectangular lamp. Indicate whether the lamp will
be a single colour (alternates between half and full luminous versions of the same colour) or
multicoloured (select a set of colours which the lamp can show).
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8.4.4.3 Edit/Write
If the lamp is set as edit/write enabled then touching the lamp will allow it to move in sequence through
colours assigned to it.

8.4.4.4 Attributes
can be assigned to the lamp as required.

8.4.4.5 Colours
When multicoloured mode is selected click on the icons within the Colours section to specify the colours
that the lamp will display.

4. Once the embedded data type is created it is displayed in the area defined earlier.

8.4.5 Switch

To embed a switch on a graphics screen:
1. Choose the Switch embedded data type.
2. Position the mouse at one corner of the area where the switch is to be drawn. Click and hold the left

mouse button.
3. Reposition the mouse to the opposite corner of the switch area and release the left mouse button.

The switch embedded data type window will appear…

Figure 8.16 - Configure Switch Embedded Data

8.4.5.1 Remote Data Source
Select where the source of the date to be used to control the switch is. This can either be a register within
the connected AE or an internal register. Drop down the data type box to select the register type to be
used and specify the register number in Location. Where AE Network mode has been selected the PLC
node ID from which this variable should be obtained can be specified in node ID.
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8.4.5.2 Display Format
Select the switch type to be displayed. In addition specify the number of positions for slider (2/3) and
rotary (2 – 8) switches.

8.4.5.3 Edit/Write
Enable to allow the user to modify the state of the switch by touching on it.

8.4.5.4 Attributes
specify any additional attributes for the shape.

4. Once the embedded data type is created it is displayed in the area defined earlier in the style
specified.

8.4.6 Sliders

Similar to the horizontal fill Horner has added a “Slider” type Analogue Meter. It is embedded on the menu
page in a similar manner to the Horizontal Meter. To embed a Slider on a graphics screen:
1. Choose the Slider embedded data type.
2. Position the mouse at one corner of the area where the slider is to be drawn. Click and hold the left

mouse button.
3. Reposition the mouse to the opposite corner of the slider area and release the left mouse button.
4. The slider configuration dialog box is displayed

Figure 8.17 - Configure Slider Animation Data Dialog Box
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8.4.6.1 Remote Data Source
Select where the source of the date to be used to control the slider is. This can either be a register within
the connected AE or an internal register. Drop down the data type box to select the register type to be
used and specify the register number in Location. Where AE Network mode has been selected the PLC
node ID from which this variable should be obtained can be specified in node ID.

8.4.6.2 Display Format
Select whether the slider is to be a knob type slider, or a pointer type slider used to indicate levels.

8.4.6.3 Range
In the range section specify the values to indicate the positions at either end of the slider range
5. Once the embedded data type is created it is displayed in the area defined earlier.

8.4.7 Curved Analogue Fills

To embed a Curved Analogue Fill area on a graphics screen
1. Choose the curved analog embedded data type.
2. Position the mouse at one corner of the area where the curved is to be drawn. Click and hold the left

mouse button.
3. Reposition the mouse to the opposite corner of the curved analog area and release the left mouse

button.The curved analog embedded data type window will appear…



CH. 8: GRAPHICS EDITOR                             30 June 2004                                                           PAGE 97
MAN0023-13

Figure 8.18 - Configure Curved Analog Embedded Data

8.4.7.1 Remote Data Source
Select where the source of the date to be used to control the shape is. This can either be a register within
the connected AE or an internal register. Drop down the data type box to select the register type to be
used and specify the register number in Location. Where AE Network mode has been selected the PLC
node ID from which this variable should be obtained can be specified in node ID.

8.4.7.2 Display Format
Select the style of the fill, along with the format of the register.

8.4.7.3 Range
Select the values which correspond to empty (minimum) and full (maximum) for the area.

8.4.7.4 Attributes
specify any additional attributes for the shape.

4. Once the embedded data type is created it is displayed in the area defined earlier.

8.4.8 Object Groups

Object groups give the means to ‘group’ together a set of object groups to produce a single graphics
element. Once grouped together the object is treated as a single element, and can be
selected/stretched/moved only as a single entity. Double clicking on the group allows the attributes of a
single component part to be edited.

8.4.9 The Part Library

1. The part library enables the means to include standard precomposed objects within graphics pages.
Position the cursor at the top left of the screen area to which the library part is to be added.

2. Click here or lick and drag the cursor to the bottom left of the area to which the part is to be added.
3. The standard part library box is displayed on screen.
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Figure 8.19 - Add Part Embedded Data Dialog Box

Select the part type from the drop down list, (Use the << and >> buttons to step through other variations
within the same part type).

8.4.10 Multipen Trends

On the Tiu3xx units trends added are automatically created in multipen format. This allows up to 12
trends to be automatically overlaid on top of each other with up to 12 pens visible.

1. Choose the trend embedded data type.
2. Position the mouse at one corner of the area where the curved is to be drawn. Click and hold the left

mouse button.
3. Reposition the mouse to the opposite corner of the curved analog area and release the left mouse

button.
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Figure 8.21 – Multipen Trend Dialog Box

4. Use the Add Trace and Remove Trace buttons to define the number of trends to be displayed within
the trend window.

5. Click on the appropriate Pen tabs to select between the various traces.
6. Select the data source, Range and pen colour for each trace within the trend.
7. Globally select the Trend width for the entire trend.
8. Globally allocate attributes to the trend.

8.5 Creating Animated Bit Maps

8.5.1 Scope
Graphic terminals allow for the use of the embedded data type Animated Bitmap Selector. The animated
bitmap consists of a set of images, which are selected dependent on the value in a register. It is the
pictorial equivalent of a text table.

8.5.2 To change the bitmap selected from graphics terminals without a touch screen.
1. Select the text string field by pressing the Pause key.
2. Move up or down the list using the Up and Down keys.
3. Press the Enter key to select the desired text string. The Id of the currently selected terminal will

be written to the register controlling the animated bitmap.
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8.5.3 To change the bitmap selected from graphics terminals with a touch screen.
In addition to the standard Pause/Up/Down/Enter edit mode available on non touch screen keypads, it is
possible to select the icon simply by touching te icon area on touch screen terminals.

8.5.4 Creating a new animated bitmap
1. In the animated bitmap assignment dialog box select NEW ANIMATED BITMAP from the pull

down box.
2. Click edit table and the size of the bitmap icon is displayed (Fig 8.12). The size of the bitmap icon

can be specified now.

Figure 8.22 – Set Bitmap Icon Size

Note: Once created the bitmap size cannot be changed directly. To change the bitmap size, the bitmap
image needs to be exported to a file, a new bitmap created the required size and the old bitmap image
imported back from the file of the original bitmap image.

3. Click OK to display the animated bitmap edit.See figure 8.13. (Note the icon table will be empty
when creating a new animated bitmap)
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8.6 The Animated Bitmap Editor

Figure 8.23 –The Animated Bitmap Editor

8.6.1 Add
Click on the Add button to add a new bitmap to the table. The editor will automatically assign an unused
ID, but this can be edited if required. The icon editor box is displayed. See 8.5.6 The icon editor.

8.6.2 Edit
Click on the Edit button to modify the currently selected bitmap. The icon editor box is displayed. See
8.5.6 The icon editor.

8.6.3 Delete
Click on the Delete button to remove the currently selected bitmap.

8.6.4 Select Mode.
The tables can be edited in 3 different modes, Decimal, Binary and Hexadecimal. In decimal mode the
selecting value is displayed in decimal and can be assigned any value between 0 and 255. In
hexadecimal the selecting value is displayed in hexadecimal and can be assigned any value between 0
and FFh. In binary mode the selecting value is displayed in decimal and can be assigned any value
between 0/1 and 31/32.

8.6.5 Auto scroll mode.
When AutoScroll mode is selected (only applicable in binary mode) The terminal will automatically scroll
through all bitmaps whose corresponding bit is matched in the controlling register.
Auto mask bits
When auto mask bits is selected the terminal will automatically disregard any irrelevant bits when reading
the value in the target terminal. When auto mask bits is selected the Data source register for the table
becomes a digital point, rather than an analog point.
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8.6.6 Default Entry
If an undefined value is entered into the Field ID table entry field (i.e., a value that has not been assigned
in any bitmap table), then normally a blank bitmap is displayed. However if the user has assigned a value
to the Default Entry in the Text Table box, then that entry number is displayed. This value is assigned by
first checking the box next to Default Entry, then entering a number in the box below.

8.6.7 Export Table
After selecting export table the standard windows save file dialog box is brought up. The filename for
saving will actually specify a set of file names containing the bitmap for each frame in the animated
sequence. For example Selecting a file name of say Lamp.bmp with a table containing entries for value 0,
1, 2, 4, and 8 will cause the bitmaps in the current table to be exported to a set of bitmaps named
lamp000.bmp, lamp001.bmp, lamp002.bmp, lamp004.bmp and lamp008.bmp.

8.6.8 Import Table
Select any icon in the set of bitmaps for the table (refer to Export Table above for the naming convention
of an exported animated bitmap) The file set will be imported back into the Animated Bitmap editor.

8.7 The Icon Editor

Figure 8.24 – Icon Editor

1. If necessary set the Field ID number (1-250).
2. Double click on the icon area in the centre of the screen. The currently registered Windows

Bitmap Editor opens the icon as a bitmap to be edited. The Icon is displayed with a checkered
design as default. In windows paint select Select All from the edit menu, and then cut.

3. Refer to the documentation for your registered Bitmap Editor for details on how to create graphic
images in the bitmap icon.
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4. Once the bitmap has been completed close the Bitmap Editor and the bitmap icon will appear in
the Icon Editor.

8.8 Draw Attributes
The properties or Attributes of a shape can be set before or after the shape is drawn.
Double click on existing shape to modify its’ attributes. Alternatively select Draw Attributes from the
settings menu to select the colour and pen style in which new objects will be created. The select colour
dialog box shown will be dependent on the Terminal type that is being configured.

Figure 8.25 Draw Attributes

TIU20x TIU30x

TIU32xx TIU4xx/TIU5xx/TIU6xx
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8.8.1 Selecting colours on Tiu4XX/TIU5XX/TIU6XX panels
On the Units with the smaller palettes selecting colours is as simple as clicking on the ink pot or pen
colour buttons to assign a colour to the respective item. On the TIU4XX/TIU5XX/TIU6XX, due to the
range of colours available the procedure is a little more complicated, but the recommended method is as
follows
i. Click on the palette area to specify a rough match for the colour required.
ii. Use the luminosity slider to the right of the palette to trim how bright/dark the colour is
iii. Trim the colour to the exact requirement using the Red, Green and Blue slider controls beneath

the palette.

Note once a colour has been trimmed to requirements it is possible to add it to a working palette by right
clicking on the appropriate pen/pot icon within the colour definition area.

8.9 Paste Options
Paste options allow the position of, and in the case of animation points the data source for, pasted objects
to be precisely controlled when adding them to a graphic screen. Use of the paste options box allows
tables and other repeating objects to be consistently aligned.

Figure 8.26 Paste Options

8.10 Auto-Adjust Size
The use of the auto adjust size facility allows the size of objects to be fixed to the optimum size required.
For example a text object will be resized to the smallest rectangle required to contain it in the current font.
Animated bitmaps are resized to be the actual size of the bitmap images.



CH. 8: GRAPHICS EDITOR                             30 June 2004                                                         PAGE 105
MAN0023-13

NOTES
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CHAPTER 9  NETWORKING

9.1 Scope
The TIU range supports a variety of industry standard networking options. The terminal type determines
the network options available on a TIU. The following networks are available on the various terminal
types.

Terminal Type Network
Tiu050 None
Tiuxx0 Modbus/Serial CsCan
Tiuxx1 CsCan
Tiuxx2 Profibus
Tiuxx3 DeviceNet

9.2 Modbus
Modbus is an industry standard protocol supported by many commercial Scada packages. Use of the
modbus protocol on the Tiu range allows connection of the Tius into such a system.

The TIU1X0 and TIU200 terminals support this protocol on their PC programming port, so in order to
connect a network of Tius to the host system a 232 to 422 converter must be used. Contact Horner for
recommendations of a suitable device. Note that when modbus networking is enabled on the TIU
programming port the programming functionality no longer operates other than for a brief three second
window immediately after the version numbers are announced on power up, or by shutting the system
down which may be done by writing to system register %SR9 using a function key macro.

TIU3X0 units support modbus on their additional communication port, which is capable of running in a two
wire RS485 mode for networking purposes.

Available registers are…

Table 9.1 – Modbus Network Registers

Type Function Description Quantity Retentive

%AIG
Network
Analog
Input

Analog inputs that can be read or written by the
modbus master. These registers are equivalent to

holding registers as defined by the modbus
specification and are accessed using modbus

functions 3 and 16. Data is in words.

32 No

%AQG
Network
Analog
Output

Analog outputs that can be read by the modbus
master. These registers are equivalent to input

registers as defined by the modbus specification and
are accessed using modbus function 4. Data is in

words.

16 No

%IG Network
Digital Input

Digital inputs that can be read or written by the
modbus master. These bits are equivalent to coils as

defined by the modbus specification and are
accessed using modbus functions 1 and 15. Data is

accessed in word chunks.

64 No

%QG
Network
Digital
Output

Digital outputs that are read by the modbus master.
These bits are equivalent to input bits as defined by
the modbus specification and are accessed using

modbus function 2. Data is accessed in word chunks.

64 No
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9.3 Serial CsCAN
Serial CsCan is a horner proprietary protocol. Use of the Serial CsCan network protocol on the Tiu range
allows connection of the Tiu to a supervisory PC using Horner’s own OPC-lite software, which allows the
Tiu data to be seamlessly integrated with various OPC supporting packages, including many scada
packages as well as, for example, Excel spreadsheets

The TIU1X0 and TIU200 terminals support this protocol on their PC programming port, so in order to
connect a network of Tius to the host system a 232 to 422 converter must be used. Contact Horner for
recommendations of a suitable device. Note that when serial CsCan networking is enabled on the TIU
programming port the programming functionality no longer operates other than for a brief three second
window immediately after the version numbers are announced on power up, or by shutting the system
down which may be done by writing to system register %SR9 using a function key macro.

TIU3X0 units support serial CsCan on their additional communication port, which is capable of running in
a two wire RS485 mode for networking purposes.

Available registers are…

Table 9.2 – Serial CsCan Network Registers

Type Function Description Quantity Retentive

%AIG Network
Analog Input

Analog inputs that can be read or written by the
serial CsCan master. Data is in words. 32 No

%AQG Network
Analog Output

Analog outputs that can be read by the serial
CsCan master. Data is in words. 16 No

%IG Network
Digital Input

Digital inputs that can be read or written by the
serial CsCan master. Data is in bits. 64 No

%QG Network
Digital Output

Digital outputs that are read by the serial CsCan
master. Data is in bits. 64 No

%R Registers The Serial CsCan master can access data within
the Tiu %R registers

240/1200
with BB

Yes with
BB option

%M Bits The Serial CsCan master can access data within
the Tiu %R registers 2400 Yes with

BB option

%SR System
Registers

The Serial CsCan master can access data within
the Tiu %SR registers 999 System

Specific

%AI Analog Inputs
Where the TIU has smartstack I/O fitted the Serial

CsCan master can access analog input Data
directly. Data is in Words

1024 No

%AQ Analog
Outputs

Where the TIU has smartstack I/O fitted the Serial
CsCan master can access analog output Data

directly. Data is in Words
1024 No

%I Digital Inputs
Where the TIU has smartstack I/O fitted the Serial

CsCan master can access digital input Data
directly. Data is in Bits

8192 No

%Q Digital Outputs
Where the TIU has smartstack I/O fitted the Serial

CsCan master can access digital output Data
directly. Data is in Bits

8192 No

9.4 CsCAN
The CsCAN network is based on the Bosch Control Area Network (CAN) and implements a protocol
designed to take maximum advantage of the global data broadcasting capability of CAN.  Using this
network protocol, up to 64 Control Stations can be linked without repeaters, and up to 253 Control
Stations can be linked by using 3 repeaters.
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The available registers are;

Table 9.3 – CsCAN Network Registers

Type Function Description Quantity Retentive

%AIG Network
Analog Input

Specially defined analog inputs that come from
the CsCan network protocol. Data is in words. 32 No

%AQG Network
Analog Output

Specially defined analog outputs that go to the
CsCan network protocol. Data is in words. 16 No

%IG Network
Digital Input

Single bit registers that come from the CsCan
network protocol. 64 No

%QG Network
Digital Output

Specially defined digital outputs that go to the
CsCan network protocol. 64 No

9.4.1 Sending Data to the CsCAN Network
The HE500TIU101/111/201 units contain a special set of registers called Global Network I/O, or simply
Global I/O. Using the CsCan protocol these bits are automatically sent through the network to all other
units on the network. Anyone unit can be made aware of the activities of any other unit on the network,
and any one unit can send a signal to any or all other unit on the network.

The global ‘I’ registers contain an image of global ‘Q’ registers located in a different units connected to the
network. The association between I registers and ‘Q’ registers is set at the destination unit.
Any ‘I’ register may be associated to one and only one ‘Q’ register, but that ‘Q’ register may be located in
any other unit on the network. Any ‘Q’ register is broadcast on the network for any or all other units to
use.

9.5 DeviceNet
9.5.1 DeviceNet Features Supported Using Operator Station Modules
It is important to determine the features that the Operator Station Modules support (when used in a
DeviceNet network) before programming, configuring, and setting up the network.

9.5.2 Communication Method
Although the DeviceNet Specification provides for two methods of establishing communication, the
Operator Station Modules implement only one of the methods, which is referred to as the Predefined
Master/Slave Connection Set.  This method provides communications typically seen in a Master/Slave
relationship and uses a DeviceNet Master/Slave protocol.

The other method of communication is through the use of the Unconnected Message Manager
(UCMM).  The Operator Station Modules do not currently support the UCMM method of communication.

9.5.3 Message Class / Message Priority
Both Explicit Messaging and I/O Connections are established using a message class known as Message
Group 2 Only. In this message class, the message priority is determined solely by the network address
of the individual nodes. The lower the node’s address, the higher its priority.

9.5.4 Types of Messages / Connections Supported
The Explicit Messaging and Polled Connection features are supported.  The following terms are
defined per the DeviceNet Specification, Release (2.0), Volume I: DeviceNet Communication Model and
Protocol.

Explicit Messaging: - Used in typical request/response-oriented networks.  Explicit Messages are used
to command the performance of a particular task and to report the results of performing the task.

Polled Connection: - Responsible for receiving the Master’s Poll Command and returning the associated
response.
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Explicit Messaging is used for the transfer of small amounts of infrequently accessed data such as
configurations or tuning.

The Polled Connection is used for data that is sent automatically between the slave and the DeviceNet
Master (Scanner) without intervention. The DeviceNet Master sends a Polled Command to a DeviceNet
Slave. Attached to the polled command is 32 words of data for the TIU to use. The DeviceNet Slave
produces or sends a Polled Response back to the DeviceNet Master.  (The Polled Response consists
of 32 words of data.)  All Operator Station modules monitor (or eavesdrop on) Polled Response
messages on the network.

The Operator Station Modules do not currently support Bit Strobed, Cyclic and Change-of-State
connections.

9.5.5 Additional Feature available in Operator Station Modules
The Horner extension of the DeviceNet protocol known as Polled Snooping is also provided.  Polled
Snooping is totally non-intrusive to DeviceNet traffic.  The Operator Station Modules monitor (or
eavesdrop on) all Polled Response messages on the network.  The data in the Polled Responses can
used by the CBREEZE project in each of the Operator Station Modules.  Their projects can make
decisions based on the snooped data.

9.5.6 DeviceNet Requirements
The following requirements must be met to integrate Operator Station Modules into a DeviceNet network
and to establish communications with a DeviceNet Master.

a. DeviceNet Node Address (MACID)
In order to communicate with a DeviceNet Master, a unique MACID must be assigned to each node on
the network.  Valid DeviceNet MACIDs are within the range of 0 - 63 inclusive (at least one master and 63
slave and/or master nodes).

b. DeviceNet Baud Rate
Each device connected to a DeviceNet network must be configured to operate at the same baud rate.
The baud rate for the Operator Station Modules can be selected to be 125K, 250K or 500Kbaud.  All
devices on a DeviceNet must be configured to operate at the same baud rate.

The available registers are

Table 9.4 – DeviceNet Registers

Type Function Description Quantity Retentive

%AIG Network
Analog Input

Specially defined analog inputs that come from
the DeviceNet network protocol. Data is in words. 32 No

%AQG Network
Analog Output

Specially defined analog outputs that go to the
DeviceNet network protocol. Data is in words. 32 No

9.5.7 Horner Extension Snooped Slaves
Most controllers that support DeviceNet slave networking communication allow snooping.  Snooping
allows the controller to gather data from other slaves on a network as the master polls that slave device.
Polled data sent from the slave to the master can be in one of two formats depending on the amount of
data the slave needs to send to the master.
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9.6 Profibus
Available registers…

Table 9.5 – Profibus Network Registers

Type Function Description Quantity Retentive

%AIG Network
Analog Input Analog inputs. Data is in words. 32 No

%AQG Network
Analog Output Analog outputs. Data is in words. 32 No

%IG Network
Digital Input Single bit input register. 64 No

%QG Network
Digital Output Single bit output register 64 No

The Profibus utilise a Master-Slave type of communication with the HE500TIUXX2 functioning as the
slave device. Up to 32 devices (Master or Slave) can be connected in one segment without using
repeaters or up to 125 devices can be connected using repeaters.

9.7 Configuring the HE500TIU10X/11X/20X for Network Communication
The following procedure configures a TIU to communicate using one of the standard networking options.
1. Select the terminal type from the edit menu.
2. From the main screen of the CBREEZE software select Network from the drop down Configuration

menu, or click on the network toolbar button
3. The Configure Network Screen will be displayed for the appropriate terminal type chosen in step 1.
4. From the Configure Network screen select the node ID and the appropriate network protocol. If

CsCAN terminal type HE500TIUXX1 is chosen then network protocol CsCAN is displayed. If Profibus
terminal type HE500TIUXX2 is chosen then network protocol Profibus is displayed. If CsCAN terminal
type HE500TIUXX3 is chosen then network protocol DeviceNet is displayed

5. Click On Enable Network.
6. Set the Node ID for the Terminal in the specified network.
7. Set the required Network Baud rate. For Profibus this is Auto Sensing.
The available Network Registers are displayed under Register Type Tabs on the Configure Network
Screen.

9.8 Programming Network Inputs
9.8.1 Network Input Registers IG & AIG
In terms of programming the Operator Station to receive data from the network, all input registers are
treated as Internal Registers on the terminal and are none retentive.

9.8.2 Configure Network Input Registers
To configure any network-input register, simply specify the source of the data.

Profibus/Modbus/Serial CsCan
Because Profibus, modbus and serial CsCan support Master/Slave type communication only, i.e. no
slave can communicate with another slave, the source of the data will always be the master device.

CsCAN
In CsCAN data by any node is available to all other nodes, therefore any other node on the network can
be the source of the data.

DeviceNet
In the DeviceNet network the master device decides what data is sent to each slave device. However with
the Horner Extension to the DeviceNet protocol, which allows each specified Snooped slave device to
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snoop on other specified Snooped slave devices. Therefore in DeviceNet network the master or any slave
device that is specified as a Snooped Node can be the source of the data.

9.8.3 Configuring Network Input Registers for all Network Protocols
1. Choose the register type from the Configure Network window. Only available registers will be

displayed
2. Double click the specific register to be configured.
3. The Configure Network Input window appears.
4. In the Data Source Box click the enable tick box.
5. Enter the node ID and register number of the data source.
 
 This procedure will map the output registers from the data source into the input register of the Operator
Station. This data can then be sent to registers on a device connected to the serial port of the Operator
Station.
 
1. Click on the enable tick box in the Data Destination box.
2. Select the register type and the register location.
3. Chose the format of the data to be stored as.
If Transmission Timeout is not chosen then the data will be sent to the serial device every time the Input
Register is updated. Else the frequency of which the data is sent to the serial device may be specified in
100 msecs.

9.9 Programming Network Outputs
9.9.1 Network Output Registers QG & AQG
In terms of programming the Operator Station to send data to the network, all output register are treated
as Internal Registers on the terminal and are none retentive. The value contained in this Internal Register
is sent to the network. The network then reads this value the frequency of which depends on the type of
network and how the network is set-up.

9.9.2 Destination of Output Registers
Profibus/Modbus/Serial CsCan
Because Profibus, modbus and serial CsCan support Master-Slave type communication only, i.e. no
slave can communicate with another slave, the destination of the data will always be the master device.
CsCAN
In CsCAN data is transmitted globally, therefore the destination of the data depends on which node wants
the data, and is configured at the receiving node end.
DeviceNet
In the DeviceNet network the master device decides what data is sent/received from each slave device.
However with the Horner Extension to the DeviceNet protocol, which allows each specified Snooped
slave device to snoop on other specified Snooped slave devices. Therefore in DeviceNet network the
master or any device that is specified as a Snooped Node can be the destination of the data.

9.9.3 Mapping Output Registers QG & AQG to a Serial Device.
All output registers maybe mapped to a device connected to the serial port of the Operator Station. From
the Configure Network window chose the output register type to be mapped (QG or AQG). Double click
the specific register to be mapped. The Configure Network Output appears.
Click the enable option.
Choose the register type from the list of available registers from the data type pull down menu.
Type in the Location of the specific register.
Choose the format the register is to be stored.
Type in the frequency the data is to be mapped in 100 msecs.
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CHAPTER 10  MATHEMATICS

10.1 Scope
The HE500TIU10X/11X/20X now contains a Mathematic Interpreter. Up to 1024 lines of Mathematic
Statements can be programmed into the terminal, and these can be split into function blocks, which are
called by the system as required. The function blocks are called on any of the following basis...

Call Method Description
Background Tasks At regularly repeating intervals, definable down to 0.01 seconds
Scheduled Tasks At a particular time (HH: MM) on specified days of the week
Function Key Presses As function keys are pressed

Table 10.1 – Call Methods

10.2 Maths Functions
Maths functions may be used for a variety of purposes.
1. Maintaining Internal Variables
2. Controlling Database Operations
3. Generating Alarms

10.3 Internal Registers
The available internal register types are as follows: -

Description Name Purpose Registers Available
Bit Input SmartStack %I Digital Input Mapping As Smartstack Set Up

Bit Output SmartStack %Q Digital Output Mapping As Smartstack Set Up
Word Input SmartStack %AI Analog Input Mapping As Smartstack Set Up

Word Output SmartStack %AQ Analog Output Mapping As Smartstack Set Up
Internal Word Register Internal %R Internal Analog Data 240/1200 with BB RAM

Internal System Register Internal %SR System Specific Data 999
Internal Bit Register Internal %M Internal Digital Data 240

Network Word Output Network %AQ Network Analog outputs Dependant on Network
Network Word Input Network %AI Network Analog inputs Dependant on Network
Network Bit Output Network %Q Network Digital outputs Dependant on Network
Network Bit Input Network %I Network Digital inputs Dependant on Network

Table 10.2 - Internal Register Types
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The Internal System Registers available are as follows: -

Name Read / Write Description
%SR01 R/W Current page ID
%SR02 R State of the up/down/pause/enter keys.
%SR03 R/W Global PLC Network Address
%SR04 R/W Contains the most recently entered password
%SR05 R Current edit variable

0 = none being edited, 1 = first editable variable active, etc.
%SR6 R/W Keyboard LED AND mask
%SR7 R/W Keyboard LED OR mask
%SR8 R/W Base Menu Page
%SR9 R/W Write zero to shut down system
%SR11 R RTC seconds
%SR12 R RTC minutes
%SR13 R RTC hours
%SR14 R RTC date
%SR15 R RTC month
%SR16 R RTC year
%SR17 R Number of days in current month
%SR18 R Number of the day in the year  (e.g. 1st February = 32)
%SR19 R RTC day of week
%SR21 R Number of accepted alarms
%SR22 R Number of unaccepted alarms
%SR23 R/W Total number of communication attempts to the PLC (Writing any value

resets all comms counters)
%SR24 R/W Number of good communication transactions
%SR25 R/W Number of bad communication transactions
%SR26 R/W Number of no communication transactions
%SR31 R Can Status See bit statuses below. Write any value to reset a Can

Error
%SR32 R Can Test Result
%SR33 R Can Off Count
%SR41 R/W Recipe Operation Database Selector
%SR42 R/W Recipe Operation Recipe Selector
%SR43 R/W Recipe Operation Field Selector
%SR44 R/W Recipe Operation Error Flag
%SR51 R/W Touch Screen Beep Enable
%SR52 R/W Notepad Data Saved Status
%SR53 R/W Set Backlight State

%SR81..100 R/W Last Accessed Record Name
%SR101.999 R/W Last Accessed Record Data Fields

Table 10.3 – System Registers
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Bit ID Name Indication
0 Receive Buffer Status Indicates that the can chip has a message available
1 Rx Data Overrun Indicates a can message has been missed
2 Transmit Buffer Status Indicates transmission buffer is available
3 Transmit Buffer

Completion
Indicates the last message for transmission has gone

4 Receiving Status Indicates a message is being received by the can chip
5 Transmitting Status Indicates the chip is currently transmitting a message
6 Error Status Indicates the can chip has detected an error
7 Can Bus Off Indicates the can chip has removed itself from the can bus
8 Can Power Fail 24V DC is not applied at the Can connector
9 Buffer Overrun Indicates can messages are being wasted

Table 10.4 Can Status Word Format

10.4 Maths Editor Window

To view and modify the contents of the Maths Editor, click the mathematics icon from the tool bar , or
choose Maths from Configure in the main menu. After doing so the Maths Editor window appears (Fig
10.1).

Figure 10.1 – Maths Editor Window

10.5 Execution of Maths Functions
Maths functions are called by starting at a specified line. The lines are processed consecutively beginning
at the start line until a line with a *END* marker is processed, or the end of the maths listing is reached.
Control may be switched using a GOTO statement in the function block or using any of the conditional
statements, which will jump to another line or END marker.
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10.6 Opcodes

The available operational statements are

Figure 10.2 – Mathematic Operations

10.6.1 No Operation

This statement causes the line to do nothing. The statement shows as a blank line.

10.6.2 Conditional

This statement compares the contents of a local store register with either the contents of another local
store register or a constant. After which an action is completed, depending on the result of the
comparison.

Figure 10.3 – Conditional Statement
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The available Comparison Tests are:

10.6.2.1 Equal

Test whether the specified register is equal to the contents of another register or a constant.

10.6.2.2 Not Equal

Test whether the specified register is not equal to the contents of another register or a constant.

10.6.2.3 Less Than 

Test whether the specified register is less than the contents of another register or a constant.

10.6.2.4 Less Than or Equal 

Test whether the specified register is less than or equal to the contents of another register or a constant.

10.6.2.5 Greater Than or Equal

Test whether the specified register is greater than or equal to the contents of another register or a
constant.

10.6.2.6 Greater Than

Test whether the specified register is greater than the contents of another register or a constant.

10.6.2.7 And

Test whether the result of performing a bitwise AND on a register and either another register or a
constant value is not zero.

10.6.2.8 Or

Test whether the result of performing a bitwise OR on a register and either another register or a constant
value is not zero.

Note:
For the AND and OR conditional statements the two values are combined in a ‘bitwise’ fashion.
The result is considered TRUE if any bits are set and FALSE if no bits are set.

Action
Depending on the result of the test any of three actions may be performed.

10.6.2.9 Set Bit
If the condition tested is TRUE then the specified bit will be set, if the condition tested is FALSE, then the
specified bit will be cleared.

10.6.2.10 Terminate Function
If the condition tested is TRUE then the maths function stops executing, if the condition tested is FALSE,
then execution continues at the next maths line.
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10.6.2.11 Jump To Line.
If the condition tested is TRUE then execution of the maths function continues at the specified line
number, if the condition tested is FALSE, then execution continues at the next maths line.

10.6.3 Bit Test

Allows the testing of individual bits and subsequent actions to be taken.

Figure 10.4 – Bit Test Statement

The bit specified is checked against the specified state. If the bit states match then the condition is
considered to be TRUE. Refer to the conditional functions section of the manual for an explanation of the
actions which may be performed on the result of the bit test.

10.6.4 Assignment

This statement assigns a value to the specified local register. The value of the register can be
mathematically manipulated before storing it the local register.

Figure 10.5 – Assignment Statement

The available assignment functions are
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10.6.4.1 Equal

This function makes one Register equal to the value in another register or to a constant value.

10.6.4.2 Plus

This function lets the programmer add the contents of a register to the contents of another register or
constant and stores the result in the specified register.

10.6.4.3 Minus

This function lets the programmer subtract the contents of a register or constant from the contents of a
register and stores in the result in the specified register.

10.6.4.4 Multiply

This function lets the programmer multiply the contents of a register by the contents of another register or
constant and stores the result in the specified register. This function has a special case that allows a
decimal fraction to be specified as the constant, for example multiply by 0.025.

10.6.4.5 Divide

This function lets the programmer divide the contents of a register by the contents of another register or
constant and stores the result in the specified register. This function has a special case that allows a
decimal fraction to be specified as the constant, for example divide by 0.3333

10.6.4.6 Modulus

This function divides one integer register by the contents of another register or by a constant, and stores
the remainder in the specified register.

e.g. register %R100 contains 18
execute %R101 = %R100 % 7
%R101 is set to the value of Reminder(18 / 7) = 4.

10.6.4.7 And

This function lets the programmer AND the contents of a register with the contents of another register or
constant and stores the result in the specified register. The AND operation is performed on a bit basis.
e.g. register %R100 contains value 85 decimal ( = b0000000001010101)
execute %R101 = %R100 AND b0000111100001111
%R101 is set to the value b0000000000000101 (=5)

10.6.4.8 Or

This function lets the programmer OR the contents of a register with the contents of another register or
constant and stores the result in the specified register. The OR operation is performed on a by bit basis.
e.g. register %R100 contains value 85 decimal ( = b0000000001010101)
execute %R101 = %R100 OR b0000111100001111
%R101 is set to the value b0000111101011111 (=3935)
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10.6.4.9 Exclusive Or

This function lets the programmer XOR the contents of a register with the contents of another register or
constant and stores the result in the specified register. The XOR operation is performed on a by bit basis.
e.g. register %R100 contains value 85 decimal ( = b0000000001010101)
execute %R101 = %R100 XOR b0000111100001111
%R101 is set to the value b0000111101011010 (=3930)

10.6.5 Bit Operation

This operational statement can perform 4 different operations on a local bit register.

Figure 10.6 – Bit Operation Statement Window

10.6.5.1 Set
Changes the bit value to 1

10.6.5.2 Clear
Changes the bit value to 0

10.6.5.3 Invert
Changes the bit value to 1, if present value is 0, or changes the bit value to 0, if present value is 1.

10.6.5.4 Pulse
Sets the specified bit high for 1 second and clears it to go low.
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10.6.6 Table Operation

This operation statement performs a number of operations on a specified table. As per figure 10.5 the
table definition is defined as the number of local registers in the table beginning at the specified local
register.

Figure 10.7 – Table Operation Window

The available operations are:

10.6.6.1 Total
This action sums the contents of the registers and stores the result in the target register.

10.6.6.2 Average
This action averages the contents of the registers and stores the result in the target register.

10.6.6.3 Maximum
This action searches the contents of the registers and stores the maximum value in the target register.

10.6.6.4 Minimum
This action searches the contents of the registers and stores the minimum value in the target register.

10.6.6.5 Move To
This action moves the contents of the registers in the table as a memory block, to a memory block
beginning at the target register

10.6.6.6 Swap With
This action exchanges the contents of the registers in the table as a memory block, with a memory block
beginning at the target register

10.6.6.7 Reset
This action resets the contents of each of the registers in the table to zero.

10.6.7 Function

This action performs a function on the contents of the specified action and stores the result in the same
register or another specified register. The available functions are: -
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10.6.7.1 Root
This function puts the square root of the contents of the first register in the second specified register.

10.6.7.2 ToBCD
This function converts the contents of the first register to Binary Coded Decimal and stores it in the
second specified register.

10.6.7.3 FromBCD
This function converts the contents of the first register from Binary Coded Decimal and stores it in the
second specified register.

10.6.8 Recipe Operation

Figure 10.8 – Recipe Operation Window

This function allows the transfer of a record to or from the recipe database. The available functions are: -

10.6.8.1 Load recipe
Loads a recipe whose id is contained within a specified internal register into the recipe data buffer within
the system registers.

10.6.8.2 Save recipe
Saves a recipe whose id is contained within a specified internal register from the recipe data buffer within
the system registers.
Note that the save operation writes the data to flash memory in the terminal. Whilst this provides optimum
data security, it also requires that other terminal operation halts whilst the flash is written to. This includes
communication with the AE, network functions and screen update.

10.6.9 Control Flow

This action allows the programmer to perform simple program flow commands within the mathematic
function. The available commands are

10.6.9.1 Pause
This command allows the programmer to pause the mathematic function for a specified number of
seconds.

10.6.9.2 Goto
This command allows the programmer to jump to a specified line number.
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10.6.9.3 Gosub
This command is similar to the Goto command however when an End command is reached the program
flow returns to the line immediately after line where the Gosub command was executed.

10.6.10 Data Transfer

Allows blocks of data to be transferred between local registers and connected devices.

Figure 10.9 – Data Transfer Operation Window

10.6.10.1 Data Transfer
Select the direction in which data will be transferred. Either to or from the AE, or alternately one of the 64
preconfigured communication blocks can be used.

10.6.10.2 Remote Register Location
Specifies the start address of where the data block will be written to or read from the connected
equipment.

10.6.10.3 Local Register Block start
Specifies where the data will be read from or written to in the Tiu. Note that only %R registers can be
used as for the data store.
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10.6.10.4 Block size
Specify the number of registers to be transferred.

10.6.10.5 Action
What to do if the specified block is not transferred correctly.

10.6.11 Network Put Heartbeat Operation

This command allows for a network heartbeat signal to be sent out on the network.

Figure 10.10 – Network Put Heartbeat Operation

Send a heartbeat to the selected network ID, this may be obtained from a local register or be a constant.
Status information for the operation will be stored if applicable in the specified Status register after the
timeout.

10.6.12 Network Get Heartbeat Operation

Figure 10.11 – Network Get Heartbeat Operation

Obtains a heartbeat from the specified network node provided it occurs within the specified timeout
period. The status of the operation is stored in the status register
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10.6.13 Network Put Data Operation

Send Data Out on the network to the as required.

Figure 10.12 – Network Put Data Operation

10.6.13.1 Network Data
ID specifes the node number for which the data is either generated (Global Data) or sent to (Directed
Data)..

10.6.13.2 Format
Select whether the data is to be sent as Global data for all nodes to receive or as Directed data (targeted
to a specific node)

10.6.13.3 Data
Is the data digital (%QGs), or analog (%AQGs). Also specify the start offset of the first register to be sent.

10.6.13.4 Source Data
Specifies where the data to be sent out is stored internally.

10.6.13.5 Num words
Specifies the size of the global data block to be sent out.
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10.6.14 Network Get Data Operation

Figure 10.13 – Network Get Data Operation

10.6.14.1 Network Data
ID specifes the node number for which the data is either generated (Global Data) or sent to (Directed
Data)..

10.6.14.2 Format
Select whether the data is to be sent as Global data for all nodes to receive or as Directed data (targeted
to a specific node)

10.6.14.3 Data
Is the data digital (%QGs), or analog (%AQGs). Also specify the start offset of the first register to be read
into local data.

10.6.14.4 Source Data
Specifies where the data is to be stored internally.

10.6.14.5 Num words
Specifies the size of the global data block to be transferred.
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10.6.15 Request Report Printout

Causes the terminal to generate the specified report.

10.6.16 Set End

This action denotes the end of a mathematic function.
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10.7 Background Functions

The HE500TIU10X/11X/20X terminals background function facility allows the terminal to continually run
up to 8 maths functions automatically, without operator intervention. These functions can be programmed
to run repeatedly after a specified time interval or be executed once on initialisation of the terminal.
To program a background function, choose Background Functions from Edit menu, in the Maths Editor
Window. Figure 10.6 shows the background function set-up window.

Figure 10.14 – Background Function Set-up Window

10.7.1 To Program a Background Function
Enable one of the 8 background functions by clicking in the tick box next to the number of the background
function.
1. Click Restart Function if the function is to be executed only on initialisation of the terminal.
2. In the Seconds field specify the time interval between executions of the function.
3. In the Call field, specify the function to be called, this is the line number where the function begins.
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10.8 Scheduled Functions

Scheduled Functions have been provided as a means of initiating functions on a time and day basis.
There are 16 schedules available each of which specifies a time of day and day of the week at which a
Maths Function is to be called.

To configure the scheduled functions for the TIU terminal select Scheduled Functions from the Edit menu.

Figure 10.15 - Scheduled Functions Window

10.8.1 To Set-Up a Schedule Function
1. Enable the schedule by clicking on the tick box corresponding to the schedule number.
2. In the Time enter the time of day at which the function is to be executed.
3. Click the day or days on which the function is to be executed.
4. In the Call field enter the mathematic function to be executed, this is the line number of the

mathematic function.
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10.9 Internal Register Tagging

Internal register tagging gives two facilities to the maths editor. One is to give names to each %R register
to aid in documenting and debugging the mathematics, the other is to allow a pair of registers to be
concatenated to form a 32 bit register, allowing maths accuracy to be increased.

Figure 10.16 – Data Tagging

In order to alter the tag or the size/sign of a number double click on the register or select it and press
ENTER. Note that when a register is selected as 32 bit the next consecutive register is used to store the
high word of the value. Hence in the displayed example %R0001 and %R0002 are used to store
TargetSpeed, while %R0003 and %R0004 are used to store the ActualSpeed. Beware – any modification
elsewhere of the high word of a variable will corrupt the value of the variable.

The range of values storable in an internal register is dependant on the size and whether or not it is
signed as follows…

Size Sign Minimum Maximum
16 Bit Unsigned 0 65535
16 Bit Signed -32768 32767
32 Bit Unsigned 0 4294967295
32 Bit Signed -2147483648 2147483647

10.10 Data Transfer Block

Local registers in the terminal can be mapped to registers in the automated equipment using the Data
Transfer Block facility. The maths feature does not allow PLC data to be used directly within the maths
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script but relies on input data being preloaded from the attached AE prior to execution and output data
being written to the AE following execution. This is because it is not practical to continually fetch data
from and send data to the AE as required whilst the maths is executing.
The data transfer facility allows the data to be read from the AE continually either periodically, or on
demand within the mathematics, and written back to the AE either when a change is detected or again on
demand within the mathematics.

10.10.1 To Add a Block Transfer

From the Edit menu choose Data Transfer Block.

Figure 10.17 – Data Transfer Block

Double click on any mapping to edit it (To add a new mapping edit a currently unused block). The
following dialog box is displayed



CH. 10: MATHEMATICS                                  30 June 2004                                                         PAGE 131
MAN0023-13

Figure 10.18 – Data Mapping Configuration

10.10.2 Block Type
Selects the direction and control mechanism of the transfer block. The following transfer types are
supported.

1 Tiu <- AE
Data is transferred from the AE and placed in Internal registers within the Tiu continually at the specified
period. Note that the specified period is only a target and is not guaranteed. Creating many transfer
blocks with a short period can reduce communication throughput in other areas, and may cause screen
display to become sluggish. It is wise to select the highest acceptable transfer period.

2 TIU -> AE
Data is automatically written to the AE whenever a change is detected within any register in the specified
block.

3 Tiu <-> AE
Data may be read from or written to the AE under the control of the Tiu. The Data transfer maths function
is used to cause the transfer to occur.

10.10.3 Remote Data Source
Select where the source of the date to be used to control the shape is. This can either be a register within
the connected AE or an internal register. Drop down the data type box to select the register type to be



PAGE 132                                                         30 June 2004                                  CH. 10: MATHEMATICS
MAN0023-13

used and specify the register number in Location. Where AE Network mode has been selected the PLC
node ID from which this variable should be obtained can be specified in node ID.
If auto mask is selected only the relevant bits within the control word to be used.

10.10.4 Local Data Source
Specifies the target register/bit in the AE target area. Where multiple registers are specified (the block
size is not 1) the first register/bit in the AE is specified.
Local Data Source
Specifies the buffer area in the Tiu for the transfer. Currently the data can only be transferred to/from %R
Internal registers in the Tiu.

10.10.5 Block Size
Specifies the number of registers to be transferred.

10.10.6 16 Bit/32 Bit registers
Use this selection to set the access size of the data within the Tiu.
In the example shown above 24 registers will be read from the AE starting at Word 5, and stored in the
Tiu Internal registers starting at %R201, Hence…
%R201 is loaded with AE Word 5
%R202 is loaded with AE Word 6
%R203 is loaded with AE Word 7 etc.

10.11 Comments

Select comments to add documentation to your mathematics script.

10.12 Using Indirection
Indirection is allowed on the %R local registers, e.g. %R10 = %R(%R40) + %R(%41). If %R40 contain
100 and %R41 contains 11, then %R10 will be sum of the contents of %R100 and %R11.

Indirection Example

To Fill %R100 to %R199 with the values 0 to 99…

Figure 10.19 - Mathematics Indirection
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In this example %R1 counts up from 0 to 99 while %R2 counts from 100 to 199. %R2 is used as the
indirection register to store the required value in the appropriate register.

10.13 Constants
CBreeze allows the entry of constants in a variety of formats

Decimal
Enter number as is e.g. 12345, -123, 0

Hexadecimal
Enter number with a leading ’x’ e.g. x12344321

Binary
Enter number with a leading ‘b’ e.g. b1000111100001111

ASCII
Up to four ASCII characters may be entered enclosed in quotes e.g. ‘ABCD’.

Scale
Applicable only to multiply and divide assignment operations a scale can be entered as a decimal
number, for example 0.0025, 12.75.
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CHAPTER 11  SmartStack™

11.1 General
Horner has now added the SmartStack™ modules from the TIU Range to the HE500TIU20X range. The
SmartStack system is a method of allowing I/O expansion on an HMI. A wide range of modules is
available including Digital and Analogue.

11.2 Installing and Removing a SmartStack Module
The following section describes how to install and remove a SmartStack Module.

Caution:   To function properly and avoid possible damage, do not install more than four
                  Smart Stack™ Modules per HE500TIU20X.

a. Installing SmartStack Modules
1. Hook the tabs.  Each SmartStack Module has two tabs that fit into slots located on the HE500TIU20X.

(The slots on the HE500TIU20X are located on the back cover.)
2. Press the SmartStack Module into the “locked” position, making sure to align the SmartStack Module

fasteners with the SmartStack receptacles on the HE500TIU20X.

b. Removing SmartStack Modules
1. Using a Flathead screwdriver, pry up the end of the SmartStack Module (opposite of tabs) and

swing the module out.
2. Lift out the tabs of the module.

Figure 11.1 – Installing a SmartStack™ Module in a TIU.
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11.3 Configuring SmartStack Module

Click on the SmartStack Configuration icon or choose SmartStack I/O from the Configuration menu.

The following configuration dialog box is displayed: -

Figure 11.1 – SmartStack Configuration

To configure a specific smartstack module click the config button to the right of the required module or
right click on the module itself.

NOTE: - After the project is downloaded to the TIU20X, on power up the TIU checks if the specified
SmartStack module is inserted. If the module is not inserted the TIU will display “SmartStack I/O Error”.
Power down TIU and insert specified SmartStack module.
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11.4 SmartStack I/O
The input and output of the SmartStack is handled within the local registers of the terminal. The local
registers and therefore the I/O of the SmartStack is then analysed or manipulated within the Maths
scripting function of the CBREEZE software. See chapter 10 for more information on the Maths Scripting
Facilities within CBreeze.

11.5 Module Addressing
The input and output register names and addresses are as follows: -

Table 11.2 I/O Address
I/O Type Address
Bit Input %Innnnn

Bit Output %Qnnnnn
Word Input %AInnnnn

Word Output %AQnnnnn

Refer to the smartstack setup for details of where each individual module is mapped in the I/O Map.

11.6 Displaying Data From SmartStack
Data from SmartStack modules can be embedded into a menu page in exactly the same way as other AE
devices. Embed the data type as normal and select the Location from the range of “Smart I/O” register
types shown in the pull down register table. The normal function can then be applied to the register value,
i.e. Range Checking, Scaling etc.

Note: The numeric default settings for Analogue modules should be set to 16 bit and signed.
Output data can be edited / scaled using the screen editor in the same way as a normal AE.
Data to / from SmartStack can also be scaled or manipulated via the Maths.

Note: The numeric default settings for Analogue modules should be set to 16 bit and signed.
Output data can be edited / scaled using the screen editor in the same way as a normal AE.

It is not possible to read and then modify Output types directly within a TIU system.  If it is necessary to
do this, it is better to use a System %R register within the Maths facility to manipulate and hold the
“master value” then assign the actual value to a %AQ register. See Chapter 10 Mathematics on writing
and calling maths functions.
Again, it is good practise to write to an Output type at only 1 point in the configuration.

Figure 11.3 – Math Example Word Output

11.7 Considerations for Shutting Down & Restarting a HE500TIU20X with I/O
Shutdow n
During a shutdown for downloading, the smartstack outputs will go to the state defined in the module
specific setup. It is important to make sure that all outputs are defined to go to a safe state when the
Tiu200 enters shutdown.

Restart
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During a restart either from a “Power Up” or from after a download, SmartStack outputs may not always
be in the mode required. This situation could be overcome by calling a Restart Maths function to correctly
initialise the SmartStack output modules.

Examples are shown below

Figure 11.4 – Math Example Initialise Outputs On Power Up

Figure 11.5 – Calling Math Function From Function Key

Figure 11.6 – Calling Math Function from Background Function
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CHAPTER 12  THE REPORT GENERATOR

12.1 General
Horner has now added the capability to print reports from the TIU1XX, TIU2XX, TIU3XX, TIU4XX,
TIU5XX and TIU6XX series of terminals. Currently only text based reports are supported. The TIU3XX,
TIU4XX, TIU5XX and TIU6XX use the onboard Centronics™ port to print reports. Contact Horner for
details of a suitable printer cable.

For the TIU1XX and TIU2XX a serial printer is required as the TIU’s programming port is used for report
printing.
Note that when Report Printing is enabled on the TIU1XX and TIU2XX programming port the
programming functionality no longer operates other than for a brief three second window immediately
after the version numbers are announced on power up, or by shutting the system down which may be
done by writing the value 0 to system register %SR9 using a function key macro.

12.2 Report Editor Window
When the report editor is selected the following window is displayed:

Figure 12.1 Report Editor Main Screen
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12.3 Configure Printer
In Report Editor Click on Printer Icon.

Figure 12.2 Configure Printer Icon

For Paper Format, configure Lines Per Page (10-240) and Characters Per Line (10-132).  Form Feed at
End Of Report can be unticked to disable form feed after report text. See Figure 12.3.

For the TIU1xx and TIU2xx, Baud Rate, Port Format and Line Feed Delay (0-200s) are configurable from
the drop down lists

                                                    
TIU1XX and TIU2XX                                              TIU3XX, TIU4/5/6XX

Figure 12.3 Configure Printer Options
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CHAPTER 13  CHARACTER GENERATOR

13.1 Scope (Not available on the HE500TIU050)
The CBREEZE software allows the user to edit, create and display on the HE500TIU10X/11X/20X special
characters.  These characters may be company logos, special symbols or multilingual, non-standard
KEYBOARD characters such as Ω, é, °, © or ±.

Note: The character set for the font double height is scaled automatically from the 8x6-character set.  The
character set for the font x4 is scaled automatically from the 16x12-character set.

Within each character set are up to 256 characters, however, not all these characters are usable and/or
editable by the user.

Table 13.1 – Make-up of a Character Set
Characters 0 to 31 System characters – not useable or editable
Characters 32 to 127 Standard keyboard characters – useable and editable although it

is not recommended the user edit these characters.
Characters 128 to 160 Editable and useable characters.  This is the area of the

character set for use.
Characters 161 to 255 Extended keyboard characters – useable and editable although it

is not recommended the user edit these characters.

13.2 To Insert a Special Character:
1. Place the pointer on the display where the character is to go.
2. Press <Ctrl> <Enter> or by clicking right mouse button.  Click on the character in the Character

Map (see Figure 5.2) to be inserted.
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13.3 To Create Or Edit a Character:
1. From Configure on the menu bar, choose Fonts.  The screen in Figure 13.1 appears.

Figure 13.1 - Character Generator Screen

2. Under Character Set, choose the Character Size to be edited.  Beside Set Name, enter a name
that describes this set.

3. Click on Map to show the total character set. The screen in Figure 5.2 appears.  The first four
rows are the standard keyboard characters, which should not be edited.  The fifth row is editable
and useable. The lower three rows are the extended keyboard characters, which should not be
edited.  Click on the character to be edited or blank box to create a character.

Figure 13.2 – Character Map

NOTE: Standard and Extended keyboard character are editable; however, this must be done with caution
as it effects how characters are displayed on the HE500TIU050/100/110, i.e., changing “4” to • causes all
4’s from the PLC to be displayed as •.  454 is displayed as •5•.

4. Under the Character Bitmap (see Figure 13.1), click on a square (pixel) to toggle that square on
or off.  The grey area is the space between characters and these squares should not be turned on.

Character Size

Character Number

Name of Set

Edit Standard
keyboard Characters

Saves Character File

Loads Character File

Doubles the size of
the 8x6 set only

Click on a square to toggle that square on or
off or drag and draw white of black lines. Shows spacing

Edit this row
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5. Go to step 3 to edit the next character.
6. Once all the characters have been created or edited, click Save File.  Choosing Yes over-writes

the current character file.  Choosing No gives the option to save this character set under a new
file name.

Note: It is possible to double the size of an 8x6-character set.  To do this click on the Double button.  It is
not possible to half the size of a 12x16-character set.  It is recommended that the 8x6-character set be
created first and then doubled.

13.4 International Keyboards
The CBREEZE software supports various international keyboard layouts.  However, if the standard or
extended keyboard characters are edited or deleted, the pressed key may appear different or not at all.
The following keyboard layouts are supported:

Table 5.2 – Supported Keyboard Layouts
Danish German (Standard)
Dutch (Belgium) Italian (Standard)
Dutch (Standard) Norwegian
English (All) Spanish (Modern Sort)
Finnish Swedish
French (Standard)
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CHAPTER 14  Graphical Alarm System

14.1 Overview:

The graphics TIU range (TIU3xx/4xx/5xx/6xx) includes a new Graphical Alarm System that provides a
method of presenting and managing alarms. Alarms are messages that are presented to the operator in
response to a specific condition in the control system. On receiving an alarm, the operator is generally
expected to take immediate corrective action and record that action by acknowledging or clearing the
alarm. In addition, the alarm system also records these events to a history log such that a supervisor can
review the number of alarm occurrences or the operator’s response to such alarms.

The Graphical Alarm System is actually three separate parts that includes an alarm manager, an alarm
object, and an alarm viewer. The alarm manager is a task, which runs invisibly in the background and
continuously monitors the configured alarm points for a change to the active state. If an alarm point goes
active, the alarm manager records that alarm along with a time/date stamp in both a summary and history
alarm log.  The alarm object is a graphical object that can be placed on either a user or alarm screen.
This object is used to notify the operator that an unacknowledged, active or an alarm entry exists. On
detection of an unacknowledged alarm, the operator can touch (select) the alarm object to display the
alarm viewer. In the alarm viewer, the operator is presented with the list of current alarm entries along
with the controls to select, acknowledge, or clear alarm entries.

14.2 Alarm points

Up to 640 alarm points (ID) can be configured for continuous monitoring by the alarm manager. During
configuration, each alarm point requires an identification string and a group number (1-16).
To configure the Alarm points Click on Configure/Alarms. The Alarms Definition Table is displayed:

Figure 14.1
Group:
Value between 1 and 16 to specify which group the alarm belongs to, (See section 14.4)
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Type:
 Alarm types are selected from the drop down list.

Figure 14.2
Definitions:

Disabled:
No Action taken.

Positive Transition:
If Data Point goes from Off to On, Alarm is Activated.

Negative Transition:
If Data Point goes from On to Off, Alarm is Activated.

Greater Than or Equal To:
If Data Point becomes Greater Than or Equal To Setpoint/ Trigger value, Alarm is activated.

Less Than or Equal To:
If Data Point becomes Equal To or Less Than Setpoint/Trigger value, Alarm is activated.

Data Point:
Can be both External (PLC, Drive, etc) and Internal Register Types.

Setpoint/Trigger:
For Transition Type Alarms a Setpoint/Trigger is not defined. For Greater Than or Equal To and Less
than or Equal To, the appropriate value is placed in the Setpoint/Trigger Field, see Figure 14.3 below

Alarm Text:Text strings of up to forty (40) characters are supported in this field. These text strings are
visible when the Alarm Viewer Screen or Alarm Logs (History/Summary) are viewed.

Fig 14.3
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Once the program is loaded, the alarm manager begins monitoring each alarm condition.  On detection of
a transition, the alarm manager changes that alarm point’s state and creates an alarm entry in both alarm
logs.  Each alarm log entry is loaded with the alarm point identification string, group, state and the time
and date of the transition.

14.3 Alarm state

The alarm state of an alarm point indicates if it is active and if it has been acknowledged or cleared by the
operator.  An alarm point is in one of four states:

ALM - Alarm point is active and is pending acknowledgement.
ACK - Alarm point is active and has been acknowledged.
RTN - Alarm point has transitioned from active to inactive (return-to-normal) while still pending

acknowledgement.
CLR - Alarm point is inactive and has no pending request for acknowledgement <or> Alarm

point is active but has been cleared.

On the first detection of an alarm point going active, the associated state changes from CLR to ALM.
That alarm’s state thereafter only changes on one of three events: the operator acknowledges the alarm,
the operator clears the alarm, or the alarm point returns to inactive without being acknowledged.

• If acknowledged, the alarm state changes to ACK and remains in that state until the alarm goes
inactive and changes to CLR.

• If cleared, the alarm state changes to CLR and remains in that state until the alarm point makes a
transition from inactive to active.

• If the alarm point goes inactive without being acknowledged, the alarm state changes to RTN.
Generally, the alarm point remains in that state until either it is acknowledged, cleared, or the
alarm points go active.   However, if the Alarm Configuration parameter “RTN Implies ACK” is
set, the alarm state thereafter immediately changes CLR.

14.4 Alarm groups

Alarm groups provide a way of categorising alarms based on plant layout, machine group, control zone,
or any other grouping of associated alarms.  For example, consider a process with several machines and
a TIU containing a user screen for each machine.  Also assume that the process alarms could also be
divided (or grouped) by machine.  On each screen, an alarm object could then be configured to only
report alarms associated with that corresponding machine.

Alarm points are assigned a group number when configured in the Alarm | Alarm Configuration menu.
Several alarm points are “grouped” it they are all assigned the same group number.  Up to 16 group
numbers can be used.

While all alarms are written to a common summary log and history log, alarm objects and the associated
alarm viewer that access these logs are configurable to selectively filter entries.   Filtering is accomplished
by specifying the alarm group or groups that each alarm object can access.
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14.5 Alarm logs

A log is a portion of internal TIU memory that contains alarm information.  The alarm manager maintains
two alarm logs that are referred to as the summary and history log.   While the differences between the
two logs are detailed below, generally the summary log contains the current active and unacknowledged
alarms while the history log contains a history of alarm state changes.  Each alarm log entry contains the
alarm point identifier, time, date, state, and group number of the alarm.  The time and date indicates the
moment the alarm transitioned to the current state.  Alarm log entries can be viewed (through group
filters) and optionally modified by the operator through the alarm viewer.

The summary log provides a single entry for each alarm point whose current state is NOT equal to CLR.
Since only one entry per alarm point is logged, the number of entices is limited to the number of alarm
points configured.  Entries are cleared on a power-cycle or program download.  Entries contained in the
summary log contain an alarm in one of the following states:

ALM – Active alarm not yet acknowledged or cleared by operator.
ACK – Active alarm was acknowledged by operator
RTN – Alarm returned to inactive without being acknowledged (optional).

If the system configuration RTN-implies-ACK in the Alarm | Alarm Configuration Menu is set, the RTN
state immediately changes to CLR.  The action prevents RTN from being shown in the summary log.

The history log provides an entry for each transition of an alarm state (history of changes).  The history
log length is limited to 128 entries and is stored in non-volatile memory.  Entries are only cleared at
program download or through operator intervention.  Once the log becomes filled, the least current entry
is deleted when a new alarm event occurs.  Noted that re-occurring alarms can quickly fill the history log.
Entries contained in the history log show alarm transitions to the following alarm states:

ALM – Alarm went active
ACK – Active alarm was acknowledged by operator
CLR – Active alarm was cleared  by operator
RTN – Alarm returned to inactive without being acknowledged.

Note that transitions from either ACK or RTN to CLR are not logged.

14.6 Alarm Object

Figure 14.4 Alarm Object

The alarm object is a graphical object, which provides two mechanisms.  The first is to visually indicate
that alarms are unacknowledged, active, or recorded in the associated ALARM LOG.  The second is to
respond to touch (selection) and display the ALARM VIEWER, which allows the user to view and
optionally modify any of the alarms in the associated alarm log.

The alarm object must be configured for attachment to either the alarm summary log or the alarm history
log.  Selecting the summary log allows the alarm object to monitor for active and unacknowledged alarms.
Selecting the history log allows the alarm object to monitor for recorded alarm entries.  In addition to the
alarm log, the alarm object must also be configured for which ALARM GROUP or groups to monitor.  This
provides a method of limiting a specific alarm object to only respond to a group (or subset) of alarms.
Additionally, the group information is also passed to the alarm viewer such that it only displays entries
from the selected group(s).
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The alarm object also supports GENERAL OBJECT PROPERTY’s attributes of Visible, Flash, and Enable
input.   This allows creative use of the object, for example:  The Visible attribute can be tied indirectly
(through ladder logic) to the alarm ladder indicators to allow an alarm object to become visible when
alarms are present.  The Flash attribute can be tied to ladder logic, which causes the legend to flash after
alarms have not been acknowledged for some period of time.  And the Enable input attribute can be tied
to ladder logic that only allows operators with certain privileges can access the alarm viewer.

14.6.1 Default Display (partial list):

By default, the alarm object is configured to display the latest entries of the associated alarm log in list
form on the surface of the object.   Background colour around the list, and a legend with a selectable font
is also configurable.   The list background is always white.

Figure 14.5 Alarm Summary/History Partial List

Only the topmost (newest) entries from the associated alarm log that fit in the alarm object’s list area are
displayed.  Each entries text colour is based on its associated alarm point’s ALARM STATE.  These list
text colours are globally defined in the Alarms | Alarm Configuration Menu in the graphics editor.  For
example, when a new alarm occurs, its entries text is displayed in the ACT colour at the top of the partial
list to alert the operator.  The operator can then display the alarm viewer and acknowledge that alarm.
On return to the alarm object’s screen, that entries text colour is changed to the ACK colour.  Should the
operator fail to acknowledge the alarm before the alarm point returned to inactive, that entries text colour
is changed to the RTN colour (if RTN Implies ACK is NOT active).

The display format of the list entries is configurable through the Alarm Object Properties dialog box.  The
displayed fields of time, date and state can be individually enabled (order of the fields in the message
cannot be altered).  Additionally, the specific time and date formats are selectable. The font of the entries
is also selectable; however, since entries are limited to single line and clipped at the right edge of the
alarm object, fonts sizes should be kept minimal.
Note also that the associated alarm viewer uses same field, format and font selections of the calling alarm
object.

14.6.2 Unacked Only:

When using the partial list to display the summary log, a configuration option Unacked ONLY is available.
Selecting this configuration option results in the alarm object only listing the latest un-acknowledged
alarm entries.  This filtering of entices is used to lesson operator distraction caused by acknowledged
entries.  The associated alarm viewer is NOT affected by this option and DOES display acknowledged
entries.
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14.6.3 Display alarm button/icon only:

An option is provided to not show the partial list on the surface of the alarm object.  Alternately, only the
legend and an optional ICON are displayed.  In addition, the background colour of the alarm object is
dynamically modified to reflect the state of entries in the associated alarm log.
These state colours are defined in the Alarms/Alarm Configuration Menu in the graphics editor and
depend on which alarm log type is selected.

Figure 14.6 Alarm Icon

When a button/icon only alarm object is attached to the summary log and a new alarm occurs, the
alarm object is displayed in the UNACK colour to alert the operator than an unacknowledged alarm exists.
The operator can then display the alarm viewer to acknowledge that alarm.  On return, the alarm object is
then displayed in the ACK colour (if the alarm is still active).  Once all alarms in the selected group(s) are
acknowledged and inactive, the alarm object is displayed in the EMPTY colour.

When a button/icon only alarm object is attached to the history log and a new alarm occurs, the alarm
object is displayed in the Not-Empty-Colour to alert the operator that entries now exist in the log.  The
operator can then display the alarm viewer to view and optionally clear the entry.  If the alarm history log
is full, the alarm object is displayed in the Full-colour to alert the operator that entries are being deleted on
new alarm state changes.  Once all alarms in the selected group(s) are cleared (and the history log is
NOT full) the alarm object is displayed in the EMPTY colour.

Note that the alarm object’s list format parameters (font, fields and format) are STILL required for an
alarm object configured for button/icon only since that information is required for the associated alarm
viewer.

14.7 Alarm viewer

The alarm viewer allows an operator to view and optionally modify entries in an alarm log.  To access the
alarm viewer, the operator must select a visible and enabled alarm object.  When selected, the alarm
viewer is displayed, consuming the full page and displaying as many alarm entries that are present and
that fit in the display area.  If more entries exist than can be displayed, a scroll bar appears to the side of
the screen to illustrate the currently displayed group of entries relative position from the beginning of the
log.   Additionally, the length of the scroll bar gives a relative indication of the number entries.  Since the
scroll bar does not respond to touch commands, control buttons (UP/DOWN) are provided to scroll
through the list and select a particular entry.

The alarm viewer only displays log entries belonging to the specified group(s) contained in the specified
alarm log.  The specified group(s) and alarm log are the same as that defined for the calling alarm object.
The alarm viewer also displays the entries in the font and format as that defined for the “calling” alarm
object.  As with the alarm object’s partial list display, each entries text is displayed in the colour
determined by its alarm state.  These list text colours are globally defined in the Picture | Configure
Alarms Monitoring in the Picture editor.  The background colour of the list is always white.

If any of the time, date or alarm state fields are enabled in calling alarm’s object format, the alarm entries
are displayed on two lines.  The first line contains the time, date or alarm state, and the second line
contains the alarm identifier (indented).  If none of the time, data or alarm state fields are enabled, each
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alarm entry only consumes a single line containing just the alarm identifier (not indented).  Alarm
identifiers that do not fit on a single line are clipped to the right edge of the display.  This needs to be
considered when selecting a font.

Figure 14.7 Alarm Viewer

The control buttons at the bottom of the alarm viewer allow the operator to modify the contents of the
specified alarm log.  Some of the control buttons can be disabled depending upon the log displayed and
the Allow Operator to Clear selection of the calling alarm object.

ACK Acknowledge selected alarm entry (summary log only)
CLR Clear selected alarm entry (if clear enabled)
ACK ALL Acknowledges all alarm entries (summary log only)
CLR ALL Clear all alarm entries (if clear enabled)
UP Select the entry above the currently selected.  If at the top of screen, scroll the

screen down one by one entry.
DOWN Select the entry below the currently selected.  If at the bottom of the screen,

scroll the screen up by one entry.
ESC Return to page containing calling alarm object.

For locating entries in large logs, the UP/DOWN keys can be held down for an extended period to enable
auto repeat.

The entry list is dynamic in that it is updated continuously while the alarm viewer is active.  Upon entry to
the list, the first alarm entry is selected (indicated by hi-lighting that entry).  The viewer attempts to
maintain the selected entry at its current position as new alarms are added or deleted.  However, in some
situations such as the selected entry being located near the beginning or end of the log, a position
change of the selected entry is required to show its relative position from the beginning or end of the log.

Should the selected entry be deleted (i.e. acknowledged alarm goes inactive), the alarm viewer attempts
to select the next entry displayed last below the deleted entry.  If unable to locate an entry displayed
below, the alarm viewer attempts to select an entry displayed above the deleted entry.  In the extreme
case that all displayed entries are deleted simultaneously, the alarm viewer selects the first entry in the
list.  Any control selected while the alarm viewer is searching for a selected entry is discarded.
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14.8  Configure Alarms Monitoring

14.8.1 Alarms Monitoring
In Cbreeze, Picture Editor, select Picture and then Configure Alarms Monitoring to select the colours
associated with various alarm log entries.

The following applies to the alarm viewer and alarm objects whose indicator mode is not set to alarm
button/icon only.

Figure 14.8 Configure Alarm Monitoring

14.8.2 List Text Colours

• ALM Colour
Specifies the colour to paint alarm log entries that are in the ALM state.

• ACK/CLR Colour
Specifies the colour to paint alarm log entries that are in the ACK or CLR state.

• RTN Colour
Specifies the colour to paint alarm log entries that are in the RTN state.

14.8.3 Summary Button Colours

The following only applies to alarm objects whose indicator mode is set to alarm button/icon only.

• UNACK Colour
Specifies the colour to paint the background of alarm objects when their associated summary log has
entries at an unacknowledged alarm state.

• ACK Colour
Specifies the colour to paint the background of alarm objects when their associated summary log has
entries at an active alarm state but NO entries at an unacknowledged alarm state.

• Empty Colour
Specifies the colour to paint the background of alarm objects when their associated summary log has
NO entries at an active or unacknowledged alarm state.
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14.8.4 History Button Colours

The following only applies to alarm objects whose indicator mode is set to alarm button/icon only.

• Full Colour
Specifies the colour to paint the background of alarm objects when their associated history log is full.

• Not Empty Colour
Specifies the colour to paint the background of alarm objects when their associated history log has
entries.

• Empty Colour
Specifies the colour to paint the background of alarm objects when their associated history log has
NO entries.
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14.9 Alarm Object Properties

Figure 14.9 Alarm Object Properties

14.9.1 Object Specific Properties:

• Summary/History
Specify which log to access.  Summary contains the current alarm states while the History log
maintains a history of each alarm change.

• Display alarm button/icon only
Specifies which indicator to present: a partial list or just a button (w/optional icon) is displayed.
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• Unacked Only (available on partial list attachment to summary log only)
Only unacknowledged alarms are displayed on the partial list.  This allows the user to ignore
acknowledged active alarms.  This option does NOT affect the alarm viewer, which displays all active
and/or unacknowledged alarms.

• Allow Operator to Clear
Enables the Clear/Clear All buttons when displaying the alarm viewer.  When enabled, the operator is
allowed to clear (remove) entries from either the summary or history logs.

• Date
This checkbox enables the display of the date of occurrence for each alarm in both the partial list and
the alarm viewer.  The corresponding list box allows selection of the specific date format.

• Time
This checkbox enables the display of the time of occurrence for each alarm in both the partial list and
the alarm viewer.  The corresponding list box allows selection of the specific time format.

• State
The checkbox enables the display of the state of each alarm in both the partial list and the alarm
viewer.

• Alarm Groups to Display
Selects which group(s) of alarms to be display by both the partial list and the alarm viewer.
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CHAPTER 15  CompactFlash®
15.1 Overview
With the addition of the SVGA TIUs (TIU4XX, TIU5XX and TIU6XX) to the TIU line-up, a CompactFlash®
port is now available for use in several different capacities.

Comma-separated text files can be read from or written to the CompactFlash® card making it possible to
datalog or otherwise store and retrieve enormous amounts of data.  These files can be read or created
using a spreadsheet program for data processing.  The ability to Delete and Rename files, as well as
moving around in a directory structure, is also available.

Many additional new features were added to the CompactFlash® functionality. With the arrival of the new
4-channel video card option, it is possible to freeze-frame an image from a video channel to a 15-bit
colour bitmap or JPEG file on the CompactFlash® card.  Also possible is a full screen capture to bitmap
or JPEG. Along with these new image options comes the ability to view those images directly on the TIU
screen by selecting one in the CompactFlash® directory.

In addition to image capture and viewing to and from CompactFlash®, it is possible to use Cbreeze to
save a program to a CompactFlash card in a special format using a card reader/writer connected to the
computer running Cbreeze. This program can then be loaded to the TIU from the CompactFlash® card at
a rate of speed far beyond the capabilities of a serial port connection.  This increase in speed is
especially noticeable on programs with large amounts of bitmap data in the graphics section of the
program. To load a Project from CF to the TIU the TIU must already have a project with an embedded CF
button (to allow loading of the Project)

15.2 Compact Flash® on screen

To embed a CompactFlash® (CF) object onscreen, open the Picture editor in Cbreeze and select the CF
button (figure 15.1)

Figure 15.1 CompactFlash® button

Click and drag an area onscreen for the object. The following is displayed

Figure 15.2 Compact Flash Manager Object Properties
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Description:

The Compact Flash Object provides both visual information about the status of the attached flash card
and provides an entry point to the CompactFlash directory.  The status information is shown as one of
three background colors which signify if the CompactFlash card is accessible, if the card is close to being
full, or if the card is not accessible (remove, invalid format, invalid card type).  If the object is touched and
is enabled, the CompactFlash directory will be displayed.  When the directory is displayed, certain
‘permissions’ are passed from the CompactFlash object such as which controls are enabled and the
Current Working Directory (CWD) to open the directory in.  The CompactFlash object also has the typical
Attribute functions.

Operations to allow:

Specifies which directory controls are enabled when zooming to CompactFlash directory.  This allows
limited control by operators.

Delete File - If checked, allows option of deleting a single file or folder when CompactFlash is accessed
using this particular object.

Delete ALL - If checked, allows option of deleting all files and folders on the card when CompactFlash is
accessed using this particular object.

Format Card - If checked, allows option of formatting the CompactFlash card when CompactFlash is
accessed using this particular object.

Change Directory - If checked, allows option of navigating through directories that are below
(subdirectories of) the Starting Directory when CompactFlash is accessed using this particular object.
Never is the user allowed to navigate to a directory above the Starting Directory.

View File - If checked, allows option of viewing Bitmap and JPEG files in certain formats when
CompactFlash is accessed using this particular object.   can be viewed or .pgm files saved to the card by
Cscape can be loaded into the unit, overwriting the existing program.

Load Application - If checked, allows option of loading a .pgm file saved to the card by Cbreeze,
overwriting the existing program.

Starting Directory

Specifies the virtual current working directory displayed in the CompactFlash directory.  The operator is
not allowed to transverse to directories above this path.  If path is non-existent, an error message is
displayed (see CompactFlash directory).

Legend

Text to be displayed on the onscreen icon.

Line Colour

Colour used for drawing borders and icon.

Card OK Colour

Colour used to paint background of object is CompactFlash card status is OK.
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Card Full Colour

Colour used to paint background of object if CompactFlash is filled at or above the limit specified with the
Percent Full specification (0 to 100 equals 0% to 100% respectively)

Card Error Colour

Colour used to paint background of object if CompactFlash card is not accessible.   The specific error
type is displayed on the CompactFlash directory or through SR176.

15.3 CompactFlash® functions

Compact Flash Functions are carried out in the Maths editor

15.3.1 Read CompactFlash csv

 

Figure 15.3 Read CompactFlash

This function allows reading a comma separated value file from the CompactFlash interface into TIU
register space.

15.3.1.1 Description of Function Parameters:

File Name – This is the filename to read the values from and enter into the TIU.  This can be a constant
or a TIU registers.  If this is a constant it can be up to 147 characters long that includes sub directories
(i.e. “my_data\test.csv”).  If the filename is stored in registers it still has a limit of 147 characters and must
be terminated with a NULL (byte containing zero).  To indicate the file is in a register, place the percent
(%) symbol before the register name.  This is used to differentiate between “R1234” which is a valid file
name and “%R1234” which is a register reference.  File and directory names are limited to the 8.3
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convention.  This is 8 characters for the name and 3 characters for an extension with a period (.)
separating them.  See the filename descriptions in the section below.

File Offset – This parameters defines where in the file to start reading data.  This can be a constant value
or a 32-bit TIU register.  For example, a csv file contains the following data “123, 456, 789”.  The value
“123” is element offset zero, the “456” is element offset one, and “789” is element offset two.

Destination Address – This is a TIU register where the read data is placed.  Because each element can
require more than one 16-bit registers (DINT, UDINT, ASCII types) and more than one element can be
read at a time this can fill a large number of registers from this starting point.

Type – This is the type of data that is read.  There is no type or size information encoded in a csv file and
it is the programmer’s responsibility to read data from a file using the correct type.

BOOL allows storing a single TIU bit as a one (1) or zero(0) in the csv file.

Binary allows storing 16-bits of data as a string of ones and zeros for example the number 123  is
represented as 0000 0000 0111 1011 in binary.  When writing this to the csv file it will write
“000000001111011,”.  This format is designed for advanced user, typical office products like Excel do not
handle this as a native format.

Number of Elements – This determines the number of element to read it can be a constant or 16-bit TIU
register.

For ASCII types this becomes “Max Number of Characters” and sets the maximum number of characters
that can be read from the file and stored in TIU registers.

For BOOL types this is always set to one.

Status – This is a 32-bit register used to show the status of the function block.  The first 16-bit register is
a status code, see the possible status codes in the status section below.  The second 16-bit register
shows the number of elements successfully read.

15.3.2 Write CompactFlash csv

Figure 15.4 Write CompactFlash
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This function allows writing a comma separated value file to the CompactFlash interface from TIU register
space.

15.3.2.1 Description of Function Parameters:

File Name – This is the filename to write the values from the TIU.  This can be a constant or a TIU
register.  If this is a constant it can be up to 147 characters long that includes sub directories (i.e.
“my_data\test.csv”).  If the filename is stored in registers it still has a limit of 147 characters and must be
terminated with a NULL (byte containing zero).  To indicate the file is in a register, place the percent (%)
symbol before the register name.  This is used to differentiate between “R1234” which is a valid file name
and “%R1234” which is a register reference.  File and directory names are limited to the 8.3 convention.
This is 8 characters for the name and 3 characters for an extension with a period (.) separating them.
See the filename descriptions in the section below.

Mode – This is the writing mode for the function.
Create – create a new file, error if file DOES exist
Append – add data to end of existing file, error if file does NOT exist
Create / Append – create the file if it doesn’t exist, append if the file does exist
Overwrite – if the file exists overwrite with a new file

Columns per Row – This defines the format for writing data to the csv file.  This can be a constant or 16-
bit TIU registers.  When a csv file is written to a table format it can be viewed is a column / row format like
a spreadsheet.  Setting this parameter determines how many elements to write in a row before a new row
is started.

Setting this value to zero will disable the generation of new rows and will generate all data as a single
row.

Examples:
3 columns per row

1 2 3
4 5 6
7 8 9

5 columns per row
1 2 3 4 5
6 7 8 9 10

End of Row Now – Setting this option will cause the row to end at the end of this write function.  See
Columns per Row above.

Source Address – This is a TIU register where the data to write is located.  Because each element can
require more than one 16-bit registers (DINT, UDINT, ASCII types) and more than one element can be
written at a time this can require a large number of registers from this starting point.

Type – This is the type of data that is written.  There is no type or size information encoded in a csv file
and it is the programmer’s responsibility to write data to a file using the correct type.
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Number of Element – This determines the number of element to write it can be a constant or 16-bit TIU
register.

For ASCII types this becomes “Number of Characters” and sets the number of characters that are written
to the file as ASCII characters.

For BOOL types this is always set to one.

Status – This is a 32-bit TIU register used to show the status of the function block.  The first 16-bit
register is a status code, see the possible status codes in the status section below.  The second 16-bit
register shows the number of elements successfully read.

15.3.3 Rename CompactFlash csv

 

Figure 15.5 Rename Compact Flash

This function allows renaming a file on the CompactFlash card.  The data in the file is not changed.

15.3.3.1 Description of Function Parameters:
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Old File Name – This is the original filename to rename.  This can be a constant or a TIU register.  If this
is a constant it can be up to 147 characters long that includes sub directories (i.e. “my_data\test.csv”).  If
the filename is stored in registers it still has a limit of 147 characters and must be terminated with a NULL
(byte containing zero).  To indicate the file is in a register, place the percent (%) symbol before the
register name.  This is used to differentiate between “R1234” which is a valid file name and “%R1234”
which is a register reference.  File and directory names are limited to the 8.3 convention.  This is 8
characters for the name and 3 characters for an extension with a period (.) separating them.  See the
filename descriptions in the section below.

New File Name – This is the new filename.  This can be a constant or a TIU register and has the same
requirements as the old filename.

Status – This is a 16-bit TIU registers used to show the status of the function block.  See the possible
status codes in the status section below.

15.3.4 Delete CompactFlash csv

Figure 15.6 Delete Compact Flash csv

This function allows deleting a file on the CompactFlash card.
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15.3.4.1 Description of Function Parameters:

File Name – This is the filename to delete.  This can be a constant or a TIU register.  If this is a constant
it can be up to 147 characters long that includes sub directories (i.e. “my_data\test.csv”).  If the filename
is stored in registers it still has a limit of 147 characters and must be terminated with a NULL (byte
containing zero).  To indicate the file is in a register, place the percent (%) symbol before the register
name.  This is used to differentiate between “R1234” which is a valid file name and “%R1234” which is a
register reference.  File and directory names are limited to the 8.3 convention.  This is 8 characters for the
name and 3 characters for an extension with a period (.) separating them.  See the filename descriptions
in the section below.

Status – This is a 16-bit TIU register used to show the status of the function block.  See the possible
status codes in the status section below.

15.3.5 Status Values Returned by CompactFlash Function Blocks
Value Description

0 Operation completed successfully

-1 End of file was reached before completing
-2 Function is active, waiting for operation to complete
-3 Function is waiting on another CF function to complete
-4 Function block is inactive (usually no power flow)

1 Card present but unknown format
2 No card in slot
3 Card present, but not supported
4 Card swapped before operation was complete
5 Unknown error

66 File / Path specified does not exist
73 Bad file descriptor (corrupt file)
77 Attempt to open / rename file that is open
81 Specified file already exist
86 Function block contains illegal parameter
88 Too many open files*
92 Attempt to write failed
94 Sharing violation*
95 No disk present*
96 Directory structure corrupt
98 Incorrect data format

15.3.6 Filenames Used with the CompactFlash Function Blocks

The TIU CompactFlash functions support the flash with a DOS/Windows standard fat-16 file system.  All
names must be limited to the “eight dot three” format where the filename contains eight characters a
period then a three-character extension.

The entire filename including any path must be less than or equal to 147 characters.

When creating filenames and directories it is sometimes desirable to include parts of the current date or
time.  There are six special symbols that can be entered into a filename that are replaced by the TIU with
current time and date information.
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Symbol Description Example
$Y Substitutes the current 2 digit year 2004 = 04
$M Substitutes the current month with a 2 digit code March = 03
$D Substitutes the current day 22nd = 22
$h Substitutes the current hour in 24 hour format 4 pm = 16
$m Substitutes the current minute
$s Substitutes the current minute

Note that all the symbols start with the dollar sign ($) character.  Date symbols are in upper case, time
symbols are in lower case.

The following are examples of the substituted time/date filenames:

Current date and time: March 1, 2004 3:45:34 PM

Filename: Data$M$D.csv = Data0301.csv

Filename: Year$Y\Month$M\aa$D_$h.csv = Year04\Month03\aa01_15.csv

Filename: Month_$M\Day_$D\$h_$m_$s.csv = Month_03\Day_01\15_45_34.csv

15.3.7 System Registers used with CompactFlash

%SR55 Status – This shows the current status of the CompactFlash interface.

Possible status values:

0 CompactFlash interface OK
1 Card present but unknown format
2 No card in slot
3 Card present, but not supported
4 Card swapped before operation was complete
5 Unknown error

%SR56 Free Space – This 32-bit register shows the free space on the CompactFlash card in bytes.

%SR57 Card Capacity – This 32-bit register shows the total card capacity in bytes.
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CHAPTER 16 Video objects
16.1 Overview
The SVGA colour touch TIU models (TIU420, TIU520…) provide the capability of displaying and
capturing video with the optional HE500VIM400 video module. Installation of this module allows the TIU
to display or capture up to four channels of NTSC or PAL video. Display of live or captured video is
accomplished by the placement of a video object on a display screen. Capture of a video frame is
accomplished either through the optional pop-up menu associated with the video object, or through the
optional video control register, which allows scripting logic control of captures. Once captured, the video
frame may be displayed, saved to Compact Flash, or both.

16.1.1 Video Captures

Each video channel has an associated capture buffer that is used to store a single video frame.  When
the freeze operation is selected from either the pop-up menu (touch) or by setting the freeze bit in the
video control register, a video frame is captured and stored to the associated channel’s capture buffer.
When a channel is frozen, any video object associated with that channel displays the captured video.  To
differentiate between observing live video or a captured frame, the video object displays a red band
around the captured video display.  When the freeze operation is released from the pop-up menu, the
image in the capture buffer is lost and the associated video object’s display returns to live video.

When the save operation is selected from either the pop-up menu, or by setting the save bit in the video
control register, the TIU first determines if that channel is already frozen and contains a valid image in its
capture buffer.  If the channel is frozen, the previously captured frame is saved to Compact Flash. If the
channel is not frozen, a capture immediate occurs to fill the capture buffer and that image is then saved to
Compact Flash. Once the save is complete and if the channel was NOT previously in freeze mode, the
image in the capture buffer is lost and the associated video object continues to display live video.

Freeze and save operations are provided separately to give the user the ability to freeze a frame,
optionally zoom to inspect the captured frame and then determine whether or not to save the captured
frame to Compact Flash. Alternately, events may trigger save operations without freezing and disrupting
the associated video objects live video display.

Warning:  Commanding a freeze operation from either the pop-up menu or the control register while a
save operation for the same channel is in progress corrupts the capture buffer being saved to Compact
flash.

Saved frame captures are stored in either Windows™ 15-bit colour bitmap or JPEG format. The save
format and path\filename for each video channel are specified in the Video Configuration. Note that the
specified path\filename may use substitution characters that allow each capture to have a unique
filename or path.
The minimum amount of time between consecutive captures (saved to CompactFlash) on a particular
channel is the sum of: start capture latency, capture completion time, and save capture to CompactFlash
completion time. Capturing multiple channels increases the minimal amount of time by that taken for each
channel.

Start time latency exists between setting the freeze or start bit in the video control register and the TIU
starting the frame capture. This value varies and is the sum of the following dependencies (latency for
interrupting active video objects is only required if a video object(s) is currently displaying on the screen):

One Scripting function schedule time (application defined)
Interrupting active video objects 180mS (max)
Initialise video channel   30mS (typical)
Sync to video input   30mS (typical)
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Once the capture is started, an additionally 100mS is required to complete the capture and save it to the
associated channel capture buffer. If multiple channels are commanded to freeze or save simultaneously,
the captures are serviced in ascending order by channel number. Furthermore, the latency for the higher
channel numbers must account for the start capture latency and the capture completion time of the lower
channel numbers.

The time required to save the current capture to Compact Flash is dependent on the file format, the
speed of the Compact Flash and if any other flash operations are currently queued. While exact write
times are not possible to predict, typical capture storage times have been under 4 seconds. When using
the optional video control register, the TIU clears the save bit when the write operation has been
completed. The user may use this functionality to more accurately determine write times and when the
next save capture operation can be started.

Video frames are always captured and saved at the full 640 x 480 resolution. Because frames are
captured at full resolution, zooming full screen from a smaller sized video object to view a frozen frame
results in no loss of quality.

16.1.2 Video Display

Up to four channels of video may be simultaneously displayed on any screen at one time. This video is
displayed through graphical video objects that may be placed anywhere on the screen and coexist with
other graphical objects. The video object generally provides two mechanisms. The first is to provide a
display of video from the associated video input channel. The second is to respond to touch (optional)
and provide either a temporary zoom-to-full-screen display or a pop-up menu (described below). Display
and touch options for the video object is specified in the Video Object configuration.

The video object supports four resolutions or sizes (full screen, 640x480, 320x240 and 160x120).
With the exception of full screen resolution, video objects are normally displayed in a windowed mode. In
windowed mode, other graphical or video objects may also be simultaneously displayed. However, since
this mode allows the display of other objects, the update rate of live video display is reduced. When a
video object is alternately sized at full screen resolution, the video object consumes the entire screen and
no other graphical objects are displayed. Thus, full screen resolution allows video to be viewed at its full
frame rate.

When a video object is configured to a windowed size and if touch is enabled, the user may at run-time
temporally zoom-to-full-screen and view the video at full resolution and full frame rate.  To return to the
original screen, the user can touch anywhere on the screen.  Note that this touch action is different than a
video object configured for full screen resolution.  With an object configured (sized) for full screen
resolution, objects may be placed on top of the video object and while not visible they still process touch
signals.

Each video object is tied to one of the four input channels available on the optional video module.  The
input channel may be specified by a configuration constant or at run-time with a 16-bit register.  The
displayed video may be live or still (captured video frame) depending on the freeze state of that channel.

Up to four video objects can appear on one screen; however, avoid overlapping video objects with other
video objects to prevent display artefacts.  Since, multiple video objects on a screen can further slow the
update rate of the live video, a priority option is available when 3 or more video objects are on the same
screen.  This priority option allows one of the video objects to be updated more often than the others thus
giving it a faster update rate.   This priority option may be assigned at initialisation or at run-time through
the pop-up menu.

The video object also supports General Object Property attributes of Visible and Enable input.  This
provides the ability to only display the object or allow touch functions under certain conditions.
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16.1.3 Video Object Pop-up Menu
When the video object is configured to Show Menu for the touch option, the following pop-up menu is
displayed when the video object is touched.  The pop-up menu option is not functional for video objects
sized at full screen resolution.  Note that some selections may be greyed out when disabled in the
object’s configuration.

Figure 16.1 Video Object Pop-up

Note that invoking the pop-up menu when the current video display is live causes the object to
immediately capture a video frame in the associated channel’s capture buffer.  Thereafter, if either the
freeze or save button is selected from the menu, that captured frame is thereafter displayed as frozen or
stored to Compact Flash (respectively).  Otherwise stated, the frame used for frozen display or saved to
Compact Flash is captured when the menu is invoked, not when the actual freeze or save button is
pressed.  Each of the buttons is described below:

• Freeze / Resume
This button allows the user to select whether to freeze the current display or resume to live video.
When freezing the display, the image in the capture buffer is displayed instead of live video and made
available to the save operation.  On selecting resume, live video is resumed and the image in the capture
buffer is no longer available to the save operation.  The button’s symbol changes to represent the state of
the next press.

• Zoom
This button allows the operator to zoom-to-full-screen to view live video or the frozen image at full screen
resolution.  When live video is shown at full screen resolution, it is displayed at its full frame rate (30 or 25
frames per second).  To return from the full screen resolution display, touch anywhere on the screen.

• Set this object to priority
When three or four video objects are shown on one page, the priority option allows displaying one of the
objects with a higher frame rate.  Enabling this menu option allows the operator to select which video
object to give the highest update priority.

• Set all equal priority
The button works in cooperation with Set this object to priority button.  When three or four video objects
are shown on one page, enabling this menu option allows the operator to set each video object at an
equal update rate.
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• Save
This button causes the captured video to be saved to Compact Flash.  When the operator presses the
save button, the frame is saved using the file name assigned in the global Video Configuration (see
below).  Note that the save button remains depressed until the save operation is complete.

• Escape
This button removes the pop-up menu from the display.

• Freeze Bit (read/write)
When this control bit is set high, a video frame is captured in the associated channel’s capture buffer.  In
addition, all video objects associated with that channel display the frozen frame.  Once this bit is reset, all
video objects associated with that channel return a live video display.  This bit also reflects the Freeze
State if controlled from a pop-menu associated with this channel.

• Save Bit (read/write)
When the control bit is set high, that channel’s capture buffer is saved to Compact Flash.  If the
associated channel is not currently in freeze mode, a video frame capture is made prior to the save.
Once the save is complete, the TIU resets the save control bit. Since, the TIU resets the bit, scripts
should only set this bit on a write request.  Once set, scripts may monitor this bit to determine when the
save operation is complete.  This bit also reflects the save state if controlled from a pop-menu associated
with this channel.

• Video Err (read only)
If the video card fails or is not present, these bits are set.

• Save Err (read / write)
If a save to Compact Flash fails (i.e. Compact Flash card full or missing), this bit is set for the appropriate
channel.
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16.2 Video Object Properties

Figure 16.2 Video Object Properties

16.2.1 Object Placement
This object can be placed anywhere on the screen and initially set to any size but is automatically re-
sized to fit the nearest supported resolution after releasing the mouse button.

16.2.2 Object Specific Properties
• Display Size
This option modifies the size of the video window and thus the size of the object. Four pre-set display
sizes of Full screen, 640x480, 320x240 and 160x120 are available (pre-set sizes allow for maximum
video update performance).  On exiting this dialog, the object re-sizes itself to match this resolution
setting.

By selecting “Full Screen”, the video object is the only object that is displayed (when visible attribute set)
regardless of other objects present on the screen.  This provides the advantage of displaying the video at
its full frame rate 30 (NTSC) or 25 (PAL) frames a second.  If the video object is configured with one of
the other display sizes, other objects are also displayed, but the video is displayed at a reduced frame
rate.  Full screen video is displayed with a small black band around the video since NTSC / PAL video is
approximately 640 x 480 and the TIU screen resolution is 800 x 600 (video is not stretched to prevent
distortions).

• Video Input Channel
This option specifies which of the four physical video input channels are displayed on this video object.
This can be either a constant from 0 to 3 or a 16-bit register address.  When using a register to control
channel selection, only the lower two bits are used (upper bits are ignored).
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• Video Config
This button invokes the global video configuration dialog.  The settings in global video configuration dialog
are not directly tied to the video object but provide access to the global parameters associated with video.
This dialog is also accessible from the main menu under Config | Video.

• Touch Options
This selects the action to performed when the video object is touched.  These options are not available if
the display size is set to full screen.

• No Action
Pressing the video object has no action.

• Zoom to Full Screen
Touching the video object switches the display to show the video full screen and at its full frame rate.
Pressing anywhere on the full screen page returns the display to normal.

• Show Menu
Touching the video object brings up a small menu that, depending on the options enabled, allows the
user to: freeze / resume the video, save the video, zoom to full screen, or adjust the video frame rate
priority.  Each menu item must be specifically enabled which determines what buttons are enabled when
presented to the user.  Note that the priority buttons are automatically disabled when less than 3 video
objects appear on a screen.

• Has Initial Priority
This option allows this video object to have the priority frame rate (updated more often then other video
objects) when the screen is initially shown.  Only one video object per screen should have this option
selected.  This option only has an effect when three or four video objects are shown on a single page.
The video object with priority frame rate can be modified at run-time with the pop-up menu.

16.2.3 Object Behaviour
• Functionality
This object continuously samples the specified TIU register (if not a constant) for a video channel change.
The object then displays on the screen the video from that video channel.  If the selected video channel is
frozen, the display shows the image in the associated capture buffer.  Else, the display shows the
selected channel’s live video.

If enabled, this object also samples touch and provides the configured action.  If configured to provide a
pop-up menu, that menu is display and sampled for the appropriate button press.
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16.3 Video Configuration

Figure 16.3 Video Configuration

• Video Control Register (Internal %SR0058)
The video control register may optionally be allocated in the global Video Configuration.  This register
may be used by control captures and obtain status on the capture success.  Four bits are allocated per
channel out of the 16-bit register.  These bits are listed on the Video Configuration Screen in Cbreeze.

• Picture Adjustment Register (Internal %SR0059 & %SR0060)
This address field allocates two consecutive 16-bit registers for controlling individual channel brightness,
contrast and colour intensity.  The first register specifies the parameter and the second specifies the
value.  Once a parameter is selected with the first register, the current value is available at the second
register.  Writing to the second register changes the parameters value.  Note that changes are volatile on
a power-cycle.
• Parameter Number:

Chan 1 Chan 2 Chan 3 Chan 4
Brightness 0 4 8 12
Contrast 1 5 9 13
Colour 2 6 10 14
Reserved 3 7 11 15
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• Value Ranges:
Brightness 0-31
Contrast 0-31
Colour 0-31

* 31 is maximum value, values greater than 31 are ignored.

• Chan ‘n’ Filename
These name entries specify the path\filename used for each video channel’s save function.  The
filenames must follow the general Compact Flash filename rules.  Specified path\filenames may also
specify substitution characters that are converted to run-time values such as date and time information
when the path or filename is create.  See filenames for more information.

• Chan ‘n’ Save Format
This entry specifies if the video channel’s capture image is saved as bitmap (16 colour) or JPEG file.

• Video Format
This specifies if the video inputs are NTSC or PAL.
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Notes
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CHAPTER 17  Ethernet

17.1 Overview – Modes of Operation

Figure 17.1 depicts an overview of an Ethernet network.  The Ethernet port has Four modes of
configuration;  EGD (Ethernet Global Data), SRTP (Service Request Transport Protocol), Modbus TCP/IP
(Slave) and ICMP (Ping).

a. IP Address
Each node in the network is assigned a unique IP Address, which is represented by 4 dotted-decimal
numbers. In existing networks, Network Administrators assign IP Addresses.  For users who need to
“build” a network, the recommended IP Address is 192.168.0.x (where x = 01 – 254 addressable nodes).
These are IP Addresses that are set aside for private, internal IP Addresses per InterNIC.

b. Group ID
In some instances, a group of 2 or more devices are configured to consume (or receive) an exchange
from a producer. A group consists of any node that produces or transfers exchanges to 2 or more nodes
or is a node that is configured to consume those particular exchanges. Up to 32 separate groups are
supported. Each group is assigned a unique Group ID between 1 and 32. A Group ID is considered an IP

CONVEYOR
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TIU

Ethernet

ETHERNET
HUB

TIU
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BaseT

CsCAN or DeviceNet Network

Note:  An Ethernet Hub is
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Figure 17.1 Example of an Ethernet network
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Address. Note, however, that each node in a group is assigned a unique IP Address. When setting
parameters for Consumed Exchanges, the value 0 is entered into the Group ID block when there is no
group.

17.2 Configuration

17.2.1 Terms and Parameters

It is essential that the user understand the following key terms and parameters in order to configure the
TIU's Ethernet module

Ethernet Global Data
(EGD)

Allows a device (producer) to transfer (exchange) data to one or more consuming
devices at a regularly scheduled transfer rate.

Service Request
Transport Protocol
(SRTP)

Allows a remote client to request services from a TIU containing the Ethernet
module.  SRTP is a Client/Server, Request/Reply Protocol and the TIU provides the
Server side of the protocol.

IP Address

Recommended
IP Address to
Build a Network

This is the unique id for a device on a network and is represented by 4 dotted-
decimal numbers.

When a user intends to “build” a network, the recommended IP Address is
192.168.0.x.   (x = 01 – 254 addressable nodes.)  This is an IP Address that is set
aside for private, internal IP Addresses per InterNIC.

Group ID When an Exchange Number is produced, it can be transferred to a consuming
device or a group of consuming devices.  Up to 32 separate groups are supported.
Each group is assigned a unique group number between 1 and 32.

When setting parameters for Consumed Exchanges, the value 0 is entered into the
Group ID block when there is no group.

Subnet Mask A Subnet is a portion of a network which shares a network address with other
portions of a network. Subnets are distinguished from one another by a Subnet
Number.  The subnet defines the size of the subnet. The default Subnet Mask is
255.255.255.0.

ICMP Ping Used for diagnostics only.  A ping signal is produced and consumed to test an
Ethernet module

17.2.2 Suggested Order of Configuration
Prior to configuration, it is recommended that a programmer use a spreadsheet and/or a drawing package
to organise the required information. It is also recommended that the physical layout of the network be
determined to include devices on the network and their locations.

1. Assign all IP addresses. There is one IP address per node. All devices require a unique IP Address
even if the device is part of a group.

2. Assign Group IDs if a producing device is going to produce (send) an exchange to more than one
consuming (receiving) device. A group includes all producing and consuming devices.

3. Determine the type of data that is going to be sent by each device.
4. Assign Exchange Numbers for each produced exchange (block of data) in Cbreeze Configuration by

pressing the Produced Exchanges Tab.  Also, set the memory range for each produced exchange.
5. Assign Exchange Numbers for each consumed exchange (block of data) in Cbreeze Configuration by

pressing the Consumed Exchanges Tab.  Also, set the memory range for each consumed exchange.



CH. 16. VIDEO OBJECTS                                30 June 2004                                                         PAGE 168
MAN0023-13

17.2.3 Configuration Procedures

The following procedures are used to configure the Ethernet module using Cbreeze Software.

1. Go to the Main Screen of Cbreeze and press Communications. Select Ethernet.
2. The Ethernet Configuration Screen appears.

Figure 17.3 Ethernet configuration screen

3. Use the mouse to select the required Ethernet Protocol by clicking the desired box.

The ICMP (Ping) is used for diagnostic purposes.  A ping signal is sent to another device and
then the ping is sent back to the originating device.

The EGD (Ethernet Global Data) allows peer-to-peer or peer-to-group data sharing.

The SRTP (Service Request Transport Protocol) allows a remote client to request services from an
TIU containing an Ethernet module. If this mode is desired, select the SRTP box. No further selection is
required.
The Modbus TCP/IP Slave allows a remote client to request services from a TIU. No further
selection is required.
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4. Set the IP Address, Net Mask, and default Gateway

The IP Address is the address of the Ethernet module that is being configured. In this example the IP
Address is 192.168.0.1.  The Subnet Mask is 255.255.255.0 and allows up to 254 devices on the subnet.

The Status Register (%SR62) is a 16-bit register written by the module to indicate operational status.
The Version Register (%SR63) is a 16-bit register written by the module to indicate the module firmware
version.

5. Use the mouse to select either ICMP (Ping) or EGD (Ethernet Global Data) by clicking the desired
box.  When appropriate, both items can be selected

The ICMP (Ping) is used for diagnostic purposes.  A ping signal is sent to another device and
then the ping is sent back to the originating device.

The EGD (Ethernet Global Data) allows peer-to-peer or peer-to-group data sharing.

17.2.4 Configure ICMP

The ICMP (Ping) mode is used for diagnostic purposes only.  Aan internally generated ping signal is
produced and consumed. The user can then check the response time.

If the ICMP (Ping) box is selected, press the Config button next to it.  The following screen appears.
The Ping Timeout indicates how often a ping signal is sent out in milliseconds.  The range available for
selection is 100 – 100,000 milliseconds.  (Figure 17.4)

The IP Address register, Internal %SR0064, is a 32-bit register read by the module to determine the IP
Address to pins.  The Ping Time register Internal %SR0065, is a 32-bit register written by the module
indicating the time millisecond the last ping took.

Figure 17.4 ICMP Configuration

After setting the ping timeout, it is necessary to go to the script program and write the ping address to the
registers. To view the ping response time, go to the Script Program or a TIU screen, and view the ping
time register.
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17.2.5 Configure EGD

a) If the EGD box (Ethernet Global Data) is selected, the screen in figure 17.5 appears. Two tabs are
available for selection: Produced Exchanges and Consumed Exchanges.

Parameters required to configure Produced Exchanges
Exchange # Type Address Produced

Period
Reply Rate
Reserved for
Future Use

Ranges for Selected Exchange

Parameters required to configure Consumed Exchanges
Exchange # Producer ID Group ID Update Timeout Ranges for Selected Exchange

Figure 17.5 Ethernet Global Data exchange screen
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17.2.6 Ethernet Global Data (EGD) Mode

a. EGD Functions
Ethernet Global Data (EGD) exchanges are designed for simple, efficient communication of sampled data
between devices. EGD is not intended for event notification where the possible loss of a sample of data
would be significant.
In the EGD mode, a device can be configured to function as:
1. A producing device, which sends or transfers an exchange (a block of data) to one consuming device

or a group of consuming devices;
2. A consuming device, which receives exchanges from a producing device;
3. Both a producing and consuming device.

Note:  An Exchange is a block of data that is assigned a numerical value by the user.

b. Exchange Configuration and Interaction
Producing and consuming devices operate asynchronously to each other.  For each device, both the data
that it produces and the data that it consumes must be separately configured.  During configuration, the
user needs to select the Produced Exchanges Tab to configure the produced exchanges and then select
the Consumed Exchanges Tab to configure the consumed exchanges.

Example of Producing and Consuming Exchanges

Figure 17.6 depicts an example where Node 1 is configured to produce or transfer a block of data
(Exchange 1) to Node 2 at a regularly scheduled transfer rate.  Node 2 consumes the block of data (a
consumed exchange.  In addition to being configured to consume Exchange 1, Node 2 is also configured
to produce (transfer) a different block of data (Exchange 2) on the network to Node 1.  Node 1 is
configured to consume Exchange 2.

c. PLC Timing (Using Timestamp Feature)
The PLC scan time and the exchange time settings are asynchronous.  The exchange time settings are
the Produced Period for produced exchanges and the Update Timeout for consumed exchanges.
Producing a data sample occurs as specified by the Produced Period.  However, the update of the data
sample to the CPU is not necessarily guaranteed to occur at that interval due to the PLC sweep time.  To
verify whether the data is new, the user can select to use the Timestamp feature.
Data consistency is handled on a per exchange basis.

d. Obtaining a Status (Status Feature)
To obtain a status, the user can select the status feature.  The following tables provide status
descriptions.

Node 1
IP Address
192.168.0.1

Node 2
IP Address
192.168.0.2

Exchange 1 produced by Node 1;  Node 2 consumes Exchange 1.
Exchange 1 sends Exchange 1 to 192.168.0.2

Exchange 2 produced by Node2;  Node 1 consumes Exchange 2.
Exchange 2 sends Exchange 2 to 192.168.0.1

Figure 17.6 Example of Exchange Interaction
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State Value Description
INVALID 0 Specified exchange is not defined on consuming node.
HEALTHY 1 Exchange is defined; Valid data was recently received.
UNHEALTHY 2 Exchange is defined but the last data sample received was invalid or

A sample was not received within a specific time period.

Table 17.1 Produced Exchange Status

Condition Description

INVALID_ERROR * Producer indicates that data in the produced exchange is invalid.  **

SHORT_ERROR * Produced exchange was received but its length was less than expected.

REFRESH_ERROR * Consumer did not successfully receive the exchange within a pre-
configured time period.

PROTOCOL_ERROR * Consumer received the exchange, but the protocol version was
incompatible with version implemented on the consuming node.

SIGNATURE_ERROR * The format of the user data in the produced exchange did not match the
expected configuration on the consuming node.

LONG_EXCHANGE The exchange was received successfully but was larger than expected.

NOT_TIMESYNCED The producer has indicated that the data is valid, but the timestamp
included in the exchange may not be accurate. **

*      This condition forces a transition to the UNHEALTHY State

**    These values are set by the producer node and are included in the produced data exchange.

Table 17.2 Consumed Exchange Status
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17.2.7 SRTP (Service Request Transport Protocol

SRTP is a GE Fanuc proprietary protocol. This allows a remote client to request services from a TIU
equipped with an Ethernet port. SRTP (Service Request Transport Protocol) is a Client/Server,
Request/Reply Protocol and the TIU provides the Server side of the protocol.  As the SRTP was designed
to provide the services available on the GE Series 90 PLC, not all services are available from the TIU.
This implementation of SRTP is mainly limited to those services required in the transport of PLC register
data. The following are Service Requests processed by the TIU:

Req. Code Service Name
0 PLC_SSTAT
1 PLC_LSTAT
4 READ_SMEM
7 WRITE_SMEM
33 CHG_PRIV_LEVEL
67 RET_CONTROL_INFO
79 SESSION_CONTROL
97 PLC_FEATURES_SUPP

The READ_SMEM and WRITE_SMEM requests are used for that Register Data Transfers and Following
Register Types are valid:

Sel. Register Type
8 %R 16 bit
10 %AI 16 bit
12 %AQ 16 bit
16 %I 8 bit
18 %Q 8 bit
20 %T 8 bit
22 %M 8 bit
30 %S 8 bit
70 %I 1 bit
72 %Q 1 bit
74 %T 1 bit
76 %M 1 bit
84 %S 1 bit

There is No configuration of the TIU required to use SRTP, other than the IP Address, Net Mask and the
check box enabling the protocol. The TIU acts a Server and responds to Requests from all Clients. SRTP
can be used simultaneously with all other protocols available on the Ethernet port.


